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Preface

Getting Started introduces you to Microsofte Windowse 98 and helps you get the
operating system up and running right away. In addition to learning how to install

Windows 98, you learn how to use the desktop and you find out about new
features. You also get information about advanced issues, such as connecting

to a network, and find answers to commonly asked questions.

How to Use Getting Started

Whether you’re already familiar with or new to an operating system such as
Windows 98, you can find useful information in the Getting Started book. You

can navigate this book several ways: you can complete the chapters sequentially,
you can use the chapter-opening outlines to find the topics you want, and you can
look up terms in the index to go directly to the information you want.

The following table is a guide to using this book.

If you are

Read

New to computers

New to Windows 98

Installing Windows 98
New to the Internet

Customizing the desktop
Configuring hardware

Appendix A, “Using a Mouse”

Chapter 3, “Using Your Desktop”
Chapter 1, “Welcome”

Chapter 2, “Installing Windows 98”
Chapter 3, “Using Your Desktop”
Chapter 4, “Customizing Your Desktop’

Chapter 2, “Installing Windows 98”

Chapter 1, “Welcome”
Appendix B, “Internet Basics”

»

Chapter 4, “Customizing Your Desktop”
Chapter 5, “Advanced Issues”
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Conventions

In Windows 98, there are usually several ways to perform a task. For example,
if you want to copy a file, you can:

= Click the Copy command on the Edit menu.

= Click the Copy toolbar button.

= Click and drag the file by using the right mouse button.

For simplicity and consistency, this book describes the menu method of
performing tasks.Other conventions used in this book are listed in the following

table.

Convention Meaning

Bold In procedures, indicates text that you type or the name of a screen
object (such as a menu or button).

Talic Indicates a glossary term.

Double-click Refers to quickly clicking the primary mouse button (usually the left
mouse button) twice. If you're using the single-click option, you
should click only once when documentation tells you to double-
click.

Right-click Refers to clicking the secondary mouse button (usually the right

mouse button) once. Right-clicking opens a shortcut menu.

The following table identifies symbols and margin icons.

Icon Meaning
» Identifies a procedure.
Indicates a reference to additional information.

If Windows Looks or Acts Differently

Because Windows 98 is customizable, your copy may vary slightly from
illustrations in this book. You may also notice slight differences in how
Windows 98 responds—for example, whether you single-click or double-click
to perform tasks.



CHAPTER 1

Welcome

i

Welcome to the Microsoft Windows 98 operating system. Working in Windows
is more fun and productive than ever. The World Wide Web is easily accessible
from anywhere in Windows. Enhancements to the desktop, taskbar, and Start
menu help you open shortcuts and programs quickly. New features help you work
faster and more efficiently, while the new design of Windows 98 makes it the
most customizable, usable version of Windows yet.

Contents

Windows 98 at a Glance

Where to Find Information
Resources Included with Windows 98
Additional Resources

If You're New to Windows

If You’ve Used Windows Before
What’s New Since Windows 95
What's Changed Since Windows 3.1



2

Getting Started

Windows 98 at a Glance

Windows is now easier to use, more reliable, and more entertaining than ever.
Many of the exciting Windows 98 features are summarized below. For more
detailed information about these features and others, see “If You’ve Used
Windows Before,” later in this chapter,

Easier to Use

Navigating around your computer is easier than ever, thanks to deskrop options
such as single-clicking to open files and the addition of browse buttons in every
window. You can now use multiple monitors with a single computer, dramatically
increasing the size of your workspace. Installing new hardware is easy because
Windows 98 supports the Universal Serial Bus (USB) standard, allowing you to
plug in new hardware and use it immediately—without restarting your computer.
With Windows 98, you can also use digital cameras and other digital imaging
devices.

More Reliable

You can access the Support Online Web site for answers to common questions
and to keep your copy of Windows up to date. Windows 98 tools can help you
regularly test your hard disk and check your system files—and even automatically
fix some problems. The troubleshooters and Dr. Watson diagnostic tool also help
you solve computer problems.

Faster

Windows and programs open faster than ever before. By using the Maintenance
wizard, you can easily improve your computer’s speed and efficiency. The power
management feature allows newer computers to go into hibernation mode and
awaken instantly, instead of requiring you to shut down and restart your
computer. Also, you can use the FAT32 file system to store files more efficiently
and save hard disk space.

True Web Integration

Using the World Wide Web is easier than ever. The Internet Connection wizard
makes connecting to the Web simple. Using Microsoft FrontPage® Express, you
can create your own Web pages. By using the Web-style Active Desktop™, you
can view Web pages in any window—you can even make your favorite Web page
your desktop wallpaper. Through the channel feature, you can subscribe to Web
sites, including those of leading content providers such as Disney and Time-
Warner. In Microsoft Outlook Express, you can send e-mail and post messages
to Internet newsgroups. Using Microsoft NetMeeting™, you can collaborate on
documents and hold conferences over the Internet. Using Microsoft NetShow,
you can play live, “streaming” media—again, over the Internet.
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More Entertaining

Windows 98 supports DVD and digital audio, so you can play high-quality digital
movies and audio on your computer. You can also watch television broadcasts
and check TV program listings by using Microsoft WebTVe for Windows.

You can dramatically change the look and sound of your desktop by applying a
theme. Several themes are included with Windows 98. Each desktop theme
includes unique wallpaper, screen savers, 3-D icons, sounds, fonts, color
schemes, and mouse pointers.

Where to Find Information

Whether you’re new to Windows or upgrading from a previous version, the
following resources can help you get the most out of Windows 98.

Resources Included with Windows 98

If you have a specific question about a feature or procedure or want general
information, try the following resources, all of which are part of the Windows 98
package.

Online Tutorial: Discover Windows 98

No matter how familiar you are with computers or with Windows, you'll find the
interactive Discover Windows 98 tutorial helpful.

Note The Discover Windows 98 tutorial may not be installed in your copy of
Windows 98. Your computer manufacturer may have deleted, modified, or
replaced the Discover Windows 98 tutorial described in this section.

If you’re new to computers, the “Computer Essentials” section is a good place to
start. It discusses basic mouse, keyboard, and desktop use. If you’ve used
computers—but not Windows 95 or Windows 98 —start with “Windows 98
Overview.” And if you’ve used Windows 95, “What's New” is a helpful
introduction to the new features in Windows 98. For information about

Microsoft Press® training materials and valuable Web sites, you’ll want to explore
“More Windows 98 Resources.”

Note The following procedure assumes that you know how to operate your
mouse. For information about using your mouse, see Appendix A, “Using a
Mouse.”
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» To start the Discover Windows 98 online tutorial
E\Rm 1. Click the Start button, and then click Run.
The Run dialog box appears.
2. In the Open box, type tour98 and click OK.
The Discover Windows 98 contents appear.

f(-':c‘;)r"rilpe“:itﬁoﬁwputer Cﬁ dows 98

Users

Press the corresponding number on
Windows 98 Overview' your keyboard or click a title to

For Users Upgrading begin.
from Windows 3.x

= What's New
For Users Upgrading
from Windows 95

:, More Windows 98
Resources

Close ]

3. Click a section name.
The selected section starts.
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Windows Help

Windows Help is your principal source of information about Windows 98.
Always available on the Start button, Help provides you with /inks to the online
version of this book, the online tutorial, the troubleshooters, the Readme files, and
the Web-based resources. More importantly, Help describes how to perform a
wide variety of tasks—from setting up a printer to connecting to the Internet.

To open Windows Help
= Click the Start button, and then click Help.
The Windows Help window appears.

=0]x]
> Expiloring Your Computer
® Exploring the Internet 4
> :smmom Accessories welcome to Halp
> ianaging Use the Help system to learn more
s Hardivaes sevl Sottwere about Windows 98.
Connecting to Networks
® Using Accessbity Features o Find answers to your questions.
® Getting Started Book: Online Version o Browse the online version of the
Troubleshocting Getting Started book.
e Connect to the Web to get
software updates.
e Troubleshoot your system.
|

Each tab helps you locate information in a different way. Use the Contents tab
to locate topics, the Index tab to look up keywords, and the Search tab to search
for text.
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You can also get help in a dialog box by clicking the question-mark button on the
title bar, then clicking the area of the dialog box about which you want

information.
Click this button for
What's This? Help
Display Properties 2]
Background I Screen Saver ] bppestance | Effects |
Web | ScreenScan Sellings
Disnlaw
Displays &l installed PCI and AGP video adapters. The adapter
for your primaty monitor is in postion 1. To use an addtional
monitor, click its video adapter, and then click the Extend my
Windows desktop onto this monitor check box . Mote
e TS, | 800 by 600 pixels
IV Extend mySWirdows deskis i Advanced... '

OK I Cancel I £poly I

Getting Started Online Version

An online copy of this book is available on the Contents tab in Windows Help.

Readme Documents

Readme documents contain late-breaking information that was unavailable when
Getting Started and Windows Help were written.

» To view Readme documents
1. Click the Start button, and then click Run.
The Run dialog box appears.
2. In the Open box, type readme.htm and click OK.

The Readme browsing page appears.
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Troubleshooters

Having a problem? Windows 98 includes a wide range of helpful troubleshooters
that assist you with many common computer problems. For instance, if you’re
having difficulty setting up a new printer, the Print troubleshooter can walk you
through the process step by step. Troubleshooters are available through Windows
Help, and they’re constantly updated and supplemented on the Support Online
Web site. You can connect to Support Online by clicking the Web Help button in
Windows Help or by connecting to:

http://support.microsoft.com/support/

Additional Resources

Several Microsoft resources provide more information about Windows 98.

If you want to visit World Wide Web sites, your computer must be connected to
the Internet. For more information about connecting to the Internet, see “Internet
Setup” in Chapter 5, “Advanced Issues.”

Windows 98 Web Site

For general information about Windows 98, visit the Windows 98 Web site at:

http://www.microsoft.com/windows98

Support Online Web Site

Use the Support Online Web site to find answers to technical questions about
Windows 98. Just type in your question. This interactive site does the rest of the
work for you, gathering resources most likely to solve your problem, such as
technical articles from the Microsoft Knowledge Base, troubleshooting tools,
patches you can download, drivers, and so on. You can connect to Support Online
by clicking the Web Help button in Windows Help or by connecting to:

http://support.microsoft.com/support/

Hardware Compatibility List

For a list of hardware that’s compatible with Windows 98, visit the following
Web address:

http://www.microsoft.com/hwtest/hcl
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Microsoft Press Books and Kits

Microsoft Press books and kits provide everything users, technicians, and network
administrators need to get the most out of Windows products. The following
Windows 98 training resources are available through Microsoft Press.

Tutorials

Microsafte Windowse 98 Starts Here™—multimedia training that uses the
actual operating system, not a simulation. (ISBN number: 1-57231-698-5)

Quick Course® in Microsofte Windowse 98—software training for people in a
hurry. (ISBN number: 1-57231-742-6)

Microsofte Windowse 98 Step by Step—procedural, self-paced training.
(ISBN number: 1-57231-683-7)

Microsofte Windowse 98 Training Kit—hands-on training for Microsoft

Certified Software Engineers, network administrators, and support technicians.
(ISBN number: 1-57231-730-2)

User Guides and References

Microsofte Windowse 98 At a Glance—easy, visual information, just when
you need it. (ISBN number: 1-57231-631-4)

Microsoft® Windows® 98 Companion—Windows 98 from the ground up for
beginning to intermediate users. (ISBN number: 1-57231-931-3)

Microsofte Windowse 98 Field Guide—compact quick reference, ideal for
laptop users. (ISBN number: 1-57231-684-5)

Running Microsoft® Windowse 98—comprehensive user guide and reference.
(ISBN number: 1-57231-681-0)
Microsofte Windowse 98 Resource Kir—the authoritative technical guide

professionals need to plan for, configure, and support Windows 98. (ISBN
number: 1-57231-644-6)

For more information about these and other training resources, visit the
Microsoft Press Web site at:

http://mspress.microsoft.com/



Chapter 1 Welcome 9

If You’re New to Windows

Even if you’re new to Windows, it’s easy to get started. The following illustration
introduces the basic elements of the Windows 98 desktop. The desktop is the
workspace that appears on your screen. You use your desktop for almost any task:
opening programs, copying files, connecting to the Internet, reading your e-mail,
and so on. What you see on your desktop varies depending on how Windows 98
is set up on your computer.

Browse through and
manage your computer.

Store frequently
used files.

Open Web browsing
software, or connect
to the Internet.

View network
resources.

Store deleted files.

] & & @
Conkrcl Panel ~ DisiUp Schedued
Netwakng  Tasks

Select an Internet

service provider.
; Orire
Hstn] | B £:0 % HM_[_IW——
Switch between, minimize, or
Start programs, restore windows.
customize your
system, and more. Switch between windows
and the desktop.

Windows 98 includes the Discover Windows 98 online tutorial, which teaches
you about Windows basics such as using the desktop. For more information about
taking the online tutorial, see “Resources Included with Windows 98, earlier in
this chapter.

As you start working in Windows 98, you may want to customize your desktop
to suit your work habits and preferences. For more information about working on
the desktop, see Chapter 3, “Using Your Desktop.” For more information about
customizing the desktop, see Chapter 4, “Customizing Your Desktop.”
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If You’ve Used Windows Before |

If you're familiar with previous versions of Windows, you’ll immediately notice
that some familiar elements have changed.

What’s New Since Windows 95

If you’re already working in Windows 95, the transition to Windows 98 is
smooth. Windows 98 refines the look and design of Windows 95 to make it easier
for you to work, and the new interface provides quicker access to the Internet than
ever before.

éﬂ* For more detailed information about any Windows 98 feature, see Windows Help.

Easier Access to the Internet

Using Windows 98, connecting to the Internet is simple—all of the tools you
need are right at hand.

s Get connected to the Internet in minutes.

If your computer isn’t already connected to the Internet, the Connect to the
Internet icon appears on your desktop. Simply double-click this icon and the
Internet Connection wizard guides you through choosing an Internet service
provider (ISP) and installing any necessary software.

= Browse the Internet using the latest technology.

Experience the advanced technology available on the World Wide Web,
including live multimedia and full support for ActiveXe and other interactive
content.
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Type Internet addresses anywhere.

You can get to the Internet from any window in Windows 98 or even from
the taskbar—all you have to do is type an address in the Address Bar.

Show Web pages on the Active Desktop.

You can now customize your desktop by using a Web page, or any other
HTML document, as wallpaper.

Subscribe to your favorite Web sites.

By subscribing to your favorite Web site, you can schedule times for
Windows 98 to automatically check the site on a regular basis and notify you
when the site is updated. In addition, Web pages that you subscribe to can be
automatically downloaded to your computer or sent via e-mail. By subscribing
to your favorite Web sites, you take the hassle out of downloads, connect
times, and busy Web servers. For information about adding Web content to
your desktop, see Chapter 4, “Customizing Your Desktop.”
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Receive the latest Web content through channels.

Using channels, you can view content from the world’s premier entertainment
and business content providers. A channel is a Web site that delivers content
straight from the Web to your computer.

Save time and money by reading offline.

With one click, you can simultaneously disconnect from the Internet and
temporarily store the current Web page on your computer. You can later read
the stored content at your leisure, which can save Internet connection
expenses.

Web Integration

With Windows 98, you can use your computer as effortlessly as you use the
World Wide Web.

Browse your computer contents.

Now you can browse your computer contents the same way you surf Web
sites. In Windows 98, the roolbar in each window includes Forward and Back
buttons. You click these buttons to navigate back and forth through folders,
documents, and Web sites. Also, using the single-click option, you can open
files and folders by single-clicking their icons—even if your computer isn’t
connected to the Internet. For information about selecting click options, see
Chapter 4, “Customizing Your Desktop.”
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Click a link once to browse
the selected item.

Computer SECIRNEN 2
A Ele Edt Viw Go Faves Heo |
Display window | seiectan semto T B &7 m| X
backgrounds by | e Bedi  Fowsd  Up || OX  Coy  Pata | Undd | ol |
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' Hard .
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Comenand  Configbak  Confiador Hetiog
flee):c;;nnem(o
description., a
2,
Sobeclsjlpin 0hddenl  [682M |5 My Computer <

= Use a Web page as a window background.

By using a Web page or other HTML document as a background in individual
windows, you can create a far more functional workspace, providing links to
any external or internal Web site. For example, you and your co-workers can
use the same Web page as a folder background. On this background, you can
display shared documents, group announcements, and any other Web page.

Create your own Web pages.

FrontPage Express is an HTML editing program. Working in FrontPage
Express, you can quickly create your own Web pages by using built-in

templates.
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Easier-to-Use Desktop

The improved Windows 98 desktop is designed for easy performance of everyday
tasks and for complete Internet integration.

= Open programs quickly from the taskbar.

Now you can add one or more customizable toolbars to the taskbar for quick
single-click access to the Web and your desktop. For example, using the Quick
Launch toolbar on the taskbar, you can open an Internet Explorer window or
read your e-mail from the desktop. By adding an Address Bar, you can quickly
2o to a Web page by typing the address. By using the Show Desktop button,
you can easily switch between windows and the desktop.

S| | & & T 9| & 50w

Click the Show Desktop button to switch
between your desktop and windows.
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= Easily open your favorite files and Web pages.

The addition of a Favorites folder to the Start menu means that you can
quickly get to often-used Web sites, to documents or folders, or to other
computers on your network.

More Powerful Searching

You can easily look for the file or information you want, whether it’s on your
computer, on a network, or on the Internet.

= Find the specific information you want.

In addition to locating files on your computer and on other computers, the
enhanced Find feature can now locate content on the Internet.
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Use Internet search engines in any window.

You can search for and browse Web pages in a single window. When you
display the Search Explorer Bar, the window splits into two frames. The left
frame always displays the current search engine and the search results to
which you can jump. If you click the link in the left frame, the page appears in
the right frame. You don’t have to click the Back button to return to the search

engine, because it’s always displayed in the left frame.
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More Entertaining

Windows 98 makes multimedia entertainment readily available to you. Video,
audio, and animated media play faster and at a higher quality than ever before.
Windows 98 supports Intele MMX technology and brings the latest multimedia
technology and programming—standard and cable television, radio, and TV
broadcasts—directly to you.

= Watch movies'by using DVD technology.

Windows 98 supports the latest generation of compact disc hardware—high-
density DVD drives. A DVD disc can contain a full-length feature movie with
sound and high resolution. In addition, you can play audio discs and even use
most existing CDs in a DVD drive.

» Watch TV on your computer.

Now you can watch TV on your monitor, even with other applications
running. If your computer has a compatible TV tuner card, you can display
broadcast and cable TV programming. Corporate information, such as training
videos, can be delivered internally to employee computers.

You can also use WebTV for Windows to set reminders, to view the online
Program Guides, and to search for television programming information on the
Web.

= Receive live media over the Web.

You can experience concerts, space missions, and other exciting events as
they’re happening. Windows 98 allows you to receive live, “streaming”
multimedia over the Web. NetShow provides an easy, powerful way to receive
live multimedia across the Internet, LANs, and corporate intranets.

More Reliable

Troubleshooting is built into Windows 98 so that if you have questions or
encounter problems, you can get answers quickly. In addition to Windows Help,
Readme documents, and this book, Windows 98 also includes several new
resources to aid you.

» Get help with troubleshooting your computer.

Use the troubleshooters to help you diagnose and solve computer problems.
Troubleshooters are available through Windows Help and on the Support
Online Web site.

= Get the latest resources on the Web.

If you have Web access, you can use the Support Online site to find answers
to frequently asked questions, get technical support, and keep your copy of
Windows 98 up to date.
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Back up your files quickly.

The Backup tool supports SCSI tape devices and makes backing up your data
easier and faster.

Tune up your system.

Maintain your system by using the Maintenance wizard. You can check your
hard disk for errors, remove unnecessary files, and improve the speed of your
favorite programs. You can also use the wizard to schedule automatic tune-ups
of your computer.

Keep records with Dr. Watson.

The Dr. Watson utility makes diagnosing and reporting software problems
easier. If an application error occurs. Dr. Watson automatically records the
events in a log.

Schedule tasks to run at convenient times.

Now you can automate maintenance tasks such as checking your hard disk for
errors or checking for e-mail when you start Windows 98. After you set up
your schedule, Task Scheduler runs in the background every time you start
Windows 98.
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&) System File Checker  Run at user logon Atuset logon 855234M 1071 Running
| 2]

{4 cbjecils] Z




Chapter1 Welcome 19

Latest Hardware Innovations

Windows 98 includes hundreds of new printer, modem, and other hardware
drivers, making hardware installation and setup more efficient than ever.

In addition to supporting DVD discs, as mentioned earlier, Windows offers
the following innovations. You can:

Hook up multiple monitors.

You can increase the size of your workspace by connecting additional
monitors to your computer. This is especially convenient if you want to
perform several tasks at the same time.

Attach hardware more easily than ever.

When you attach hardware to a Universal Serial Bus port, Windows 98
automatically detects the new device and installs the necessary drivers,
allowing effortless installation of hardware—without restarting your
computer.

New Tools

Additional tools in Windows 98 help you save energy, protect your computer,
and customize your personal settings.

Save power and reduce drive wear with OnNow power management.

If you’re using a newer computer, the OnNow utility can help you save power,
prevent drive wear, and reduce drive noise. After a period of inactivity,
OnNow puts your computer in an off-but-ready mode. For information about
how you can use this feature, see your computer’s documentation.

Change accessibility options easily.

Windows 98 includes two new accessibility tcols. The Accessibility wizard
helps you adapt Windows options to specific needs and preferences. Microsoft
Magnifier enlarges any screen area.
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New Ways to Communicate

You can communicate over the Internet more easily than ever. Using the Internet
tools included with Windows 98, you can send e-mail, chat, and view
newsgroups. Using NetMeeting, you can even simultaneously hold conference
calls and collaborate with the participants on a document.
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Outlook Express can send and receive HTML messages instead of plain text, so
your messages look like Web pages (complete with links and text formatting).
Messages appear in a three-pane window so you can preview their contents.
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What’s Changed Since Windows 3.1

The Windows 98 desktop is easier to use and helps you work faster. Not only
does Windows 98 have many new features and accessories, you’ll also find that
customizing your workspace and setting up new hardware are much easier.

Program Manager

The desktop and the Start button replace Program Manager as your starting point

You can run Prqgram for most Windows tasks. You can use the Start button at any time—no matter
Manager by typing how many applications are open—to start programs, open documents, customize
progman in the Run your system, get Help, and find items.

dialog box.
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ol

You can run File
Manager by typing
winfile in the Run
dialog box.

=]

Run Command

You can still use the Run command to start programs, open folders, and connect
to network resources. The Run command is now located on the Start menu.

To use the Run command
1. Click the Start button, and then click Run.
The Run dialog box appears.
2. Type the path or the program name, and then click OK.

File Manager

The tasks that you performed in File Manager, such as copying or renaming files,
are now done on the desktop or in Windows Explorer, which displays all of your
drives in one window.

To open Windows Explorer
1. Click the Start button, and then point to Programs.
2. Click Windows Explorer.

Control Panel

You can change all of your computer settings—from adding programs and fonts
to customizing your desktop—in Control Panel.

To open Control Panel
1. Click the Start button, and then point to Settings.
2. Click Control Panel.

Print Manager

To set up a printer or to check the status of documents you’re printing, open the
Printers folder. :

To open the Printers folder
1. Click the Start button, and then point to Settings.
2. Click Printers.
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MS-DOS Prompt

You can start MS-DOSe-based programs from the command prompt.

» To open an MS-DOS window
1. Click the Start button, and then point to Programs.
2. Click MS-DOS Prompt.

Window Control Buttons

You can work with open windows in Windows 98 by clicking one of the window
control buttons located on the far right of the title bar.

Button Name Use to

E Minimize Minimize a window. A minimized window is still open, and a
window button appears on the taskbar.

]| Maximize Enlarge a window to its largest possible size.
Restore Return a window to its previous size.
E Close Close a window.
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CHAPTER 2

Installing Windows 98

The Windows 98 Setup wizard makes changing operating systems easier than
ever. You can install Windows 98 in two ways. The method you use depends on
your current computer setup.

Contents
Before You Begin
Running Windows 98 Setup
Installing from Windows 95
Installing from Windows 3.1
Performing a New Installation
Selecting Setup Options
Logging On to Windows 98
Registering Your Copy of Windows 98
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Before You Begin

Before you install Windows 98, make sure your computer meets the following
minimum system requirements:

= 486DX, 66 MHz or higher processor.

= 16 MB of RAM. (More memory improves performance.)

= Adequate space available on your hard disk. The amount of space required
varies with your installation method and the options you select during Setup.

Installation method Hard disk space required

Upgrade from Windows 95 or 3.1 120-295 MB (typically 195 MB)

New installation, FATI6 file system 165-355 MB (typically 225 MB)
 New installation, FAT32 file system 140-255 MB (typically 175 MB)

= VGA or higher-resolution monitor.

s CD-ROM or DVD-ROM drive. (If you prefer to use floppy disks instead of a
CD, the Windows 98 box contains a coupon for obtaining Windows 98 on 3.5-
inch, high-density disks. The CD-ROM version contains items not included on
the 3.5-inch disks.)

= Microsoft Mouse or compatible pointing device.

Certain features have additional requirements:

= For Internet access, 14,400 modem or fax modem and a service provider, such
as MSN. (The service provider may charge a fee.)

s For sound, a sound card and speakers; or headphones; or USB speakers
(requires a computer with USB support).

= For DVD Video, a DVD-ROM drive and compatible DVD decoder card (or
DVD decoder software).

» For broadcast reception, a Pentiume processor and compatible TV tuner card.
(Reception depends on availability of broadcast sources within your area.)

If you have access to the World Wide Web, you can view the Hardware
Compatibility List for Windows 98. The list is located at the following Web
address:

http://www.microsoft.com/hwtest/hcl

To run Setup, you need to have the Windows 98 CD (or floppy disks) or network
access to Windows 98 files. You also need a blank 3.5-inch, high-density disk
ready for formatting as your Startup Disk. It's recommended that you read the
Setup.1xt file on your Windows 98 disc for any late-breaking information. It’s also
recommended that you back up the existing files on your computer. For more
information, see “Backing Up Your Files” in Chapter 5, “Advanced Issues.”
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Running Windows 98 Setup

You can install Windows 98 in two ways. If you're currently using Windows 95
or Windows 3.1, you can upgrade to Windows 98 and retain your system settings.
Or you can perform a new installation, which will set up an entirely new copy of
Windows 98 on your hard disk—with no old system settings.

These sections describe how to install Windows 98. Chapter 5, “Advanced
Topics,” provides more detailed information about using the FAT32 file system,
installing specific components after Windows is already set up, and creating
Startup Disks.

Installing from Windows 95

When you upgrade from Windows 95, Setup automatically transfers your
previous system settings and installed programs.

Note During Setup, the Windows 98 Setup wizard automatically restarts your
computer several times.

» To upgrade to Windows 98

If you don't have 1. Start Windows 95.

enough hard disk . . -

spacg 1o instal 2. Close all programs, including any anti-virus programs.

Windows 98, try For information about closing an anti-virus program, see the program

emptying your documentation and the Setup.txt file on your Windows 98 CD.

Recycle Bin. 3. Insert the Windows 98 CD into your CD-ROM drive (or Setup Disk 1 into
your floppy disk drive).

4. If a message appears asking if you want to upgrade, click Yes. The
Windows 98 Setup wizard starts. You're finished with this procedure. Follow
the instructions that appear on your screen.

If a message doesn’t appear, click the Start button, click Run, and then
proceed to Step S.

The Run dialog box appears.
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5. In the Open box, enter the location of the Windows 98 CD. Type the drive
letter, followed by a colon (:), a backslash (\), and the word setup

For example:
d:\setup
Run : T KIEd

=559 Type the name of a program, folder, document, of Intemet
resource, and Windows will open i for you.

Open: [d\setup |

Of l Cancel I Brm,,l

6. Click OK.
The Windows 98 Setup wizard starts.
7. Follow the instructions that appear.

For information about specific screens and the information they request, see
“Selecting Setup Options,” later in this chapter.

Installing from Windows 3.1

When you upgrade from Windows 3.1, Setup automatically transfers your current
system settings and installed programs.

Note During Setup, the Windows 98 Setup wizard automatically restarts your
computer several times.

» To upgrade to Windows 98
1. Start Windows 3.1.
2. Close all programs, including any anti-virus programs.

For information about closing an anti-virus program, see the program
documentation and the file Setup.txt on your Windows 98 CD.

3. Insert the Windows 98 CD into your CD-ROM drive (or Setup Disk 1 into
your floppy disk drive).

4. Open Program Manager.
5. On the File menu, click Run.

The Run dialog box appears.
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6. In the Open box, enter the path and filename of the setup file. That is, type the

drive letter, followed by a colon (z), a backslash (\), and the word setup
For example:
d:\setup

7. Click OK.

The Windows 98 Setup wizard starts.

8. Follow the instructions that appear.

For information about specific screens and the information they request, see
“Selecting Setup Options,” later in this chapter.

Performing a New Installation

If you perform a new installation, Setup installs Windows 98 in a new folder and
doesn’t transfer any existing system settings. Windows 98 becomes your default
operating system and uses standard system settings. Because this is an entirely
new installation of Windows, you’ll need to reinstall any existing programs you
want to use.

Note During Setup, the Windows 98 Setup wizard automatically restarts your
computer several times,

> To perform a new installation using the CD-ROM version of Windows 98

1.

Insert a Windows 98 Startup Disk in the floppy disk drive.

Note For information about creating a Startup Disk, see Chapter 5, “Advanced
Topics.”

. Restart your computer.

The Microsoft Windows 98 Startup menu appears.

. Insert the Windows 98 CD into your CD-ROM drive.
. Type the number 1 and press ENTER.

A series of scans is performed, and then the MS-DOS prompt appears.

. At the MS-DOS prompt, type the word setup and press ENTER.

A message informs you that Setup is going to perform a check.

If this message doesn’t appear, then your computer can’t locate your CD-ROM
drive. For information about installing the correct CD-ROM driver, consult
your drive’s documentation or contact your hardware manufacturer.
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. Press ENTER.

Microsoft ScanDisk checks your disk drives for errors.

. When ScanDisk finishes, press the X key.

After Setup initializes, Windows 98 Setup begins.

. Follow the instructions that appear.

Note If you're using the upgrade version of Windows 98, Setup may ask you
to insert your original Windows 95 or Windows 3.1 disks.

» To perform a new installation using the floppy disk version of Windows 98

I
2.
3.

4.

Insert Setup Disk 1 into your floppy disk drive.

Restart your computer.

At the MS-DOS prompt, type the word setup and press ENTER.
The Windows 98 Setup wizard starts.

Follow the instructions that appear.

For information about specific screens and the information they request, see
“Selecting Setup Options,” later in this chapter.

Selecting Setup Options

During Windows 98 installation, the Setup wizard may ask you to make some
selections and provide certain information. The following sections describe some
of the wizard screens and the information they request from you.

Product Key screen

Type the Product Key in the spaces provided. The Product Key is located either
on the Certificate of Authenticity or on the back of your Windows 98 CD
container. If the number you type is not accepted, check the following:

Make sure Caps Lock is not on.

If you are using the keypad to the right of your keyboard, make sure Num
Lock is on.

Make sure you are not using the letter "1" for the number one.
Make sure you are not using the letter "o" for the number zero.



Chapter 2 Instaliing Windows 98 31

Select Directory screen

If you want to install Windows 98 files in a folder (directory) other than
C:\Windows, click Other Directory and type the path to the folder you prefer. If
you specify a folder that doesn’t exist, the wizard creates the folder for you.

Setup Options screen

You can customize your version of Windows by choosing the components that are
installed on your hard disk. The Setup Options screen asks you to select the type
of setup you prefer. You can choose from four setup options.

= Typical Click this button if you want all of the components that are usually
installed with Windows 98. Most users should select this Setup option.

= Portable Click this button if you want to install the options generally
required for laptop or other portable computers.

= Compact Click this button if you want the smallest possible installation of
Windows 98. For example, you may want to perform a Compact installation if
your hard disk doesn’t have much free space. Setup then installs no optional
components. If you later want to use an optional component, such as WebTV
for Windows or Games, then you have to install it. To install an optional
component after Setup is completed, use Add/Remove Programs in Control
Panel.

= Custom Click this button if you want to choose which optional components
are installed. If you don’t select a Custom installation, then Setup installs only
the optional components that are selected by default. If you know you're going
to need certain Windows components, you may want to select a Custom
installation and ensure that those components are included during Setup.

Select Components screen

On this screen, you can choose the options installed with Windows 98. Most items
in the Components list represent groups of options. For example, the Accessories
component contains several options, including Paint and the Windows 98 tour. To
view the options that are included with a component, click Details.

Windows Components screen
On this screen, you choose whether or not to view a list of installation options.

If you select Install the most common components, Setup continues the
installation. If you select Show me the list of components so I can choose, the
Select Components screen appears. You then choose the individual options you
want to be installed on your hard disk.
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>

To select or deselect installation options

= To view or change the individual options in a component, click the
component, and then click Details.

A dialog box appears, showing you the options in the component you selected.
Here you can select the specific options you want. In this dialog box and on
the Select Components screen, you can compare the space available on your
hard disk with the amount of space required by the options you select.

Identification screen

On this screen, you enter a name and description for your computer. If your
computer is connected to a network, this information identifies your computer to
other users.

Establishing Your Location screen

On this screen, you should probably select the country in which you live. Your
selection here controls the channels available on your Channel Bar. That is, the
Web content available on your Channel Bar will be of particular interest to people
from the country you select.

For more information about the Channel Bar, see Chapter 4, “Customizing Your
Desktop.”

Logging On to Windows 98

If you forget your
password, you can
enter a new user
name and still use
Windows 98, but you
may not be able to
use your old settings.

Whenever you start Windows 98, the Welcome to Windows dialog box appears,
asking you to log on. When you log on, you're identifying yourself to the
computer. In addition to providing security, this identification allows Windows 98
to save your personal settings, such as the arrangement of your desktop, your
recently used documents, and your Favorites. You're also asked to type a
password. If you’re upgrading from Windows 95 or Windows 3.1, Windows 98
uses your current logon information.

Type a user name and password to log on to Windows.
?9,
X User name: 'Aaope _lCamd
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If you’re on a computer network, you may also be asked for a domain name and
network password. This request appears in a second, similar dialog box. If you
don’t know your domain name or network password, contact your network
administrator.

For information about changing your Windows 98 and network passwords, see
“passwords” on the Index tab in Windows Help.

» To log on to Windows 98 for the first time
1. In the Welcome to Windows 98 dialog box, type your user name and
password, and then click OK.
Your password appears as asterisks (*) on the screen. If you don’t want to use
a password, you can leave the box blank and click OK.

2. In the Set Windows Password dialog box, type your password again in the
Confirm New Password box, and then click OK.

The Windows 98 desktop appears. Installation is complete, and you can start
using Windows 98.

Registering Your Copy of Windows 98

After you’ve logged on, you should register your copy of Windows 98 to ensure
that you receive product support and updated product information. If you have a
modem, you can register by starting the Registration wizard in the Welcome to
Windows 98 dialog box.
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CHAPTER 3

Using Your Desktop

If you’ve used Windows before, you’ll notice that the Microsoft Windows 98
desktop looks and works differently. The integration of Windows 98 and the
Internet provides both dramatic changes and subtle enhancements—a new look
and new ways to work. If you’ve used the World Wide Web before, you'll
recognize the browser-like windows and toolbars in Windows 98. But even if
you’ve never browsed the Web, you'll find the Windows 98 desktop easy and
fun to use.

Contents
What Is the Desktop?
Welcome to Windows 98
Exploring Your Computer
The Taskbar and the Start Button
My Computer
Windows Explorer
Network Neighborhood
Getting Your Work Done
Working with Programs
Managing Files and Folders
Shutting Down Your Computer
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What Is the Desktop?

After you start Windows 98, the first thing you see is the desktop, the area on the
screen where you work. Think of the desktop as your personalized workspace.

Several icons, or small pictures, are located on the left side of your desktop. Each
icon represents an object, such as a folder or a program. Depending on how your
computer is set up, your icons may be different from those in the illustration.

Icons —|
Start
button —Msw| (B &AW | |E 3z

T
Taskbar

Welcome to Windows 98

When Windows 98 starts for the first time, the Welcome to Windows 98 screen
appears.

Note You can also open Welcome to Windows 98 by clicking the Start button,
pointing to Programs, pointing to Accessories, pointing to System Tools, and
then clicking Welcome To Windows.
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A

Register Now
Welcome to the exciting new world of Windows
I Connect to the Internet B3, ‘Where ol compliter destitap meets the
- Discover Windows 98 Internet!

Maintain Your Computer Sit back and relax as you take a brief tour of

B Show this screen each time Windows 98 starts.

the options available on this screen.

If you want to explore an option, just click it.

From this screen, you can:

Register your copy of Windows 98. Click Register Now and ensure that you
receive product support, free product updates, and tips and tricks.

Connect to the World Wide Web and Internet right away. Click Connect to
the Internet to get online quickly and easily.

Take a tour. Whether or not you're new to Windows, you'll find the Discover
Windows 98 tours informative. Click Discover Windows 98 to learn about
essential computer skills, Windows 98 basics and features, and additional
resources.

Improve your computer’s performance. Click Maintain Your Computer to
make your programs run faster, check your hard disk for problems, free up
hard disk space, and schedule regular maintenance tasks.
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Exploring Your Computer

You can navigate around your computer in several different ways. For example,
you can view your computer’s contents by using either My Computer or Windows
Explorer. Both navigational tools are easy to find—My Computer opens from the
desktop, and Windows Explorer opens from the Start menu.

The following table compares some of the navigational tools you can use.

Displays drives and
Navigational method Located on  network computers Best for
Start button Taskbar No Starting programs, opening
Favorites, getting Help,
shutting down
My Computer Desktop Yes (network only if Exploring your disk drives
mapped to drive letter) and using system tools
Windows Explorer  Start menu Yes Seeing hierarchy of all
computer contents and
resources, in one window
Network Desktop Yes (network only)  Browsing the computers
Neighborhood on your network

The Taskbar and Start Button

To add a shortcut to
the Start menu, drag
the folder or program
to the Start button.

You can use the taskbar and Start button to easily navigate through Windows 98.
Both features are always available on your desktop, no matter how many windows
you have open.

Buttons on the taskbar show you which windows are open, even if some windows
are minimized or hidden beneath another window. You can easily switch to a
different window by clicking its taskbar button.

Using the Start button, you can accomplish almost any task. You can start
programs, open documents, customize your system, get Help, search for items on
your computer, and more. Some commands on the Start menu have a right-facing
arrow, which means additional choices are available on a secondary menu. If you
place your pointer over an item with an arrow, another menu appears.
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Depending on how your computer is set up, your Start menu may look slightly
different from the following illustration.

%wm Update Keep your computer
View a list of = tuned and get technical
your programs. iz Brogams ’ support.
[ Favortes ————— Open your favorite files
Open a recently A and Web pages.
opened document. (2§ Documents Y
By setings ———1— Modify desktop
Search for files or system settings.
or folders. Q) End »
Open items such as Web Help (-
pages, programs, and 5 @ Goel}ra"f;?i':n:’
other computers' resources. - @ Aun.. yourg '
]
26T
é &, Log0itAsor.. ——— Log off a Windows session.
£ () shuDown..

l_—‘ l:Shut down or restart your computer.
» To use the Start menu
1. Click the Start button.
The Start menu appears.
2. Click the item you want to open.

Point to items with right-facing arrows to open secondary menus.
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My Computer

My Computer is helpful if you prefer viewing the contents of a single folder or
drive. When you double-click My Computer on your desktop, available drives
appear in a new window. When you double-click a drive icon, a window displays
the folders contained on that drive. You can then double-click a folder to see the
files it contains.

Some of the following icons may appear in your My Computer window.

Double-

click To

==} View the contents of the hard disk, which is usually designated drive C.
= View the contents of a network drive, if your computer is connected to

one.

View the contents of a compact disc in the CD-ROM drive, if your
computer has one.

View tools you can use to modify your computer settings.

Set up a printer and view information about available printers and print job
status.

o & B

Schedule or view tasks for computer maintenance.

View shared information on another computer by using a modem.

View the folder contents.

DR B
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» To use My Computer to view your hard disk
1. On the desktop, double-click My Computer.
The My Computer window appears.

| Be Eat _YM? “w H = ] |

¢ o . @ % ® |
| Bk Foverd Up Cut Copy  Paste | I
]Adduslﬂﬁytompﬂu = ji
(3% Floppy (&) (] ) Printers  Control Panel

& (&
DialUp Scheduled
Networking Tasks

[7 cbiect(s) [ 123 My Computer 7

2. Double-click the icon that represents your hard disk.
Your hard disk window appears, and the contents of your hard disk appear.

Windows Explorer

If you prefer to look at your files in a hierarchical structure, you'll like using
Windows Explorer. Instead of opening drives and folders in separate windows,
you can browse through them in a single window. The left side of the Windows
Explorer window contains a list of your drives and folders, and the right side
displays the contents of a selected folder. You can use the View menu to change
how the icons in the right half of the window appear.

» To use Windows Explorer to view your hard disk
1. Click the Start button, point to Programs, and then click Windows Explorer.
2. In the left pane, click the letter that represents your hard disk.
The contents of your hard disk appear in the right pane.
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Explosing - Hard disk (€
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Network Neighborhood

Todisplay a network A nerwork is a group of computers connected to one another so that they can share
drive in My Computer,  resources, such as files and printers. If your computer is connected to a network,
right-click Network you can use Network Neighborhood to browse network resources in the same way

Neighborhood, click <

Map Network Drive, you browse the contents of your own computer.

and then select the T twork

drive letter and path. 0 open network resources
1. On the desktop, double-click Network Neighborhood.

The computers in your workgroup appear. If you want to view all of the
resources available on the network, double-click Entire Network.
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=] AaronE
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2. Double-click the servers and folders you want to open, just as you would open
drives and folders on your own computer.
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Getting Your Work Done

Now that you’re familiar with the Windows 98 desktop and the different methods
of navigating, you’re ready to learn how to perform everyday tasks, such as
starting programs and managing your iiles,

Note The procedures in this book describe the double-click method of browsing.
If you’re using the single-click option, point to an icon to select a file and single-
click the icon to open the file.

For more information about changing your browsing options, see “Choosing a
Desktop Style” in Chapter 4, “Customizing Your Desktop.”

Working with Programs

Windows 98 makes it easy for you to install, start, and quit your favorite
programs.

Adding and Removing Programs
You can quickly install programs, such as a word processing program or a game,
using the Add/Remove Programs feature in Control Panel.

For more information about adding and removing programs, look up “programs”
on the Index tab in Windows Help.
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» To install a program
1. Click the Start button, point to Settings, and then click Control Panel.
2. Double-click Add/Remove Programs.
The Add/Remove Programs Properties dialog box appears.

Instal/Uninstal | Windows Setup | Startup Disk |

J To install a new program from a floppy disk or CD-ROM
= drive, click Install

77)  Ihe lolowing software can be icaly i by
Windows. To remove a program of to modiy s installed
components, select it from the fist and click.
Add/Remove.

Fidigemove

3. Follow the instructions that appear.

Note You can also add and remove Windows components by clicking the
Windows Setup tab and following the instructions that appear on your screen.

Starting and Quitting Programs

Most of the programs installed on your computer are available from one
convenient location—the Programs section of the Start menu. Depending on how
your computer is set up, what you see on the Start menu varies.

g For more information about starting programs, look up “programs” on the Index
tab in Windows Help.
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» To start a program
1. Click the Start button, and then point to Programs.
The Programs menu appears.

2. Point to the group (such as Accessories) that contains the program you want
to start, and then click the program name.

Gty
(ZIntemet Explorer » = Multimedia »
» (E)0nkne Services > () System Tooks »
(E)statlp » 5 Cacudator
» B MSD0S Prompt (i DiskUp Networking

43 Windows Exploret  [4]Imaging
{ANotepad

3} Phone Disler

— Close button
[ =
2|e
2|Q
. [78
A
s NE
oz
olo
( < | _’!:l
IIIIIIIIEIIIII
N FrEr T EE R e
{For Help, click Help Topics onthe | | 4

Note You can also open a program by clicking Run on the Start menu, typing
the path and name of the program, and then clicking OK.

» To quit a program
= Click the Close button in the upper-right corner of the program window.
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Managing Files and Folders

In Windows 98, you can organize your documents and programs to suit your
preferences. You can store these files in folders, and you can move, copy, rename,
and even search for files and folders.

For more information about folders, look up “folders™ on the Index tab in
Windows Help.

Creating Folders

When you use a program and save your work, or when you install a program,
you’re creating files. You can store your files in many locations—on the hard
disk, a network drive, a floppy disk, and so on. To better organize your files, you
can also store them in folders.

» To create folders
1. On the desktop, double-click My Computer.
The My Computer window opens.

[ 5]

. Double-click the disk drive or folder in which you want to create a folder.
The drive or folder window opens.
3. On the File menu, point to New, and then click Folder.

|

B : ‘
| Back Forad Up

|

g 4l opy
| Adcie};JJ C\QuattedySales ;l

]

[1 object(s) selected | 2 My Computer 4

4. Type a folder name, and then press ENTER.
The new folder appears in the location you selected.

Note File names in Windows 98 can be up to 255 characters, including
spaces. However, file names cannot contain any of the following characters:
A |
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You can also search
for computers, people,
and Internet sites
using the Find

command on the Start >

menu.

To narrow your
search, click the
Date tab or the
Advanced tab.

Finding Files and Folders
When you’re looking for a particular folder or file, you can use the Find command
instead of opening numerous folders. The Find command lets you quickly search
a specific drive or your entire computer.
To find a file or folder
1. Click the Start button, point to Find, and then click Files or Folders.

The Find dialog box appears.

In Named, type the file or folder name you want to find.

W

Click the Look in down arrow, or click Browse to specify where to search.
4. Click Find Now.

After a moment, the results of the search appear.

A Find Flos named sles __—_—_______PIIES|
Flo. b View Joont el o mes e iin s
Name & Location | Date | Advanced |
FindNow |
Named: [sales | ci |
Containingest: | New Search |
Look v = | ®
¥ Include subfolders Browse. I
Name I In Foldet [ S:el Type
115 Quarter Sales =] File Folder
[2) Industry Sales Awards doc =3 C\ 11KB  WordPad Document
) Sales us 1 CAWINDOWSA 14KB  Microsoft Excel Wor
4| | 2]
[3fefslfond  |MontongNewltems

Opening Files and Folders

After you've located the file you want, you can double-click to open it.

To open a file or folder
1. On the desktop, double-click My Computer.
The My Computer window opens.
2. Double-click the drive that contains the file or folder you want to open.
3. Double-click the file or folder.
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Renaming Files and Folders
If you decide to change the name of a file or folder, you can quickly rename it.

To rename a file or folder

1. In a window, select the file or folder you want to rename.
2. On the File menu, click Rename.

3. Type a name, and then press ENTER.

Copying and Moving Files and Folders

When you create files and folders, you may want to copy or move them to another
location. Unless you’re an advanced user, you should avoid moving program and
system files.

To copy or move a file or folder

" 1. In a window, select the file or folder you want to copy or move.

Note You can select multiple items. To select nonadjacent items, hold down
CTRL and click the items you want to select. To select adjacent items, hold
down SHIFT while you select items. To select all of the items in a window, on
the Edit menuy, click Select All

2. On the Edit menu, click Copy to copy the file, or click Cut to move the file.
3. Double-click the folder in which you want to place the file or folder.
4. On the Edit menu, click Paste.

The file appears in its new location.

Working with Frequently Used Files

You can quickly open documents and programs that you use often. The Start
menu lists the documents used most recently, so that you can quickly reopen
them. The My Documents folder on your desktop is a convenient place for you to
store frequently used files and folders.

And for easy access to a file that you use frequently, you can also create a
shortcut to it. A shortcut doesn’t change the location of a file—the shortcut is just
a pointer that lets you open the file quickly. If you delete the shortcut, the original
file isn’t deleted.



Chapter 3 Using Your Desktop

» To open recently used documents
1. Click the Start button, and then point to Documents.
A list of your recently opened documents appears.
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2. Click a document on the list.

The document opens.

» To move a file to the My Documents folder
= Drag the file to the My Documents folder on your desktop.

» To create a shortcut to a file
1. Use the right mouse button to drag the file to the desktop.
2. On the menu that appears, click Create Shortcut(s) Here.

The shortcut appears on the desktop. You can copy or move the shortcut to
another location.
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To restore a file that
you deleted, double-
click Recycle Bin,
select the file, and

then on the File

menu, click Restore. >

Deleting Files and Folders

Whenever you delete a file, it’s temporarily moved to the Recycle Bin on your
desktop. If you change your mind, you can restore the file. However, when you
empty the Recycle Bin, all of the items in it are permanently deleted from your
computer.

To delete files and folders
1. On the desktop, double-click My Computer.
The My Computer window appears.
2. Select the file or folder you want to delete.
3. On the File menu, click Delete.
The Confirm File Delete dialog box appears.
4. Click Yes.
The file is moved to the Recycle Bin.

To permanently delete files

1. On the desktop, double-click Recycle Bin.
The Recycle Bin opens.

2. On the File menu, click Empty Recycle Bin.

Shutting Down Your Computer

E4

When you're finished working in Windows 98, you use the Shut Down command on
the Start menu to close windows and programs and prepare your computer for
shutting down. If you haven’t already saved your work, you’re prompted to do so.

For more information about shutting down your computer, look up “shutting
down” on the Index tab in Windows Help.

Important Don’t turn off your computer until you see a message telling you that
shutdown is complete. If you turn off your computer without shutting it down
correctly, you risk losing information.
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» To shut down your computer
1. Click the Start button, and then click Shut Down.
The Shut Down Windows dialog box appears.

o T PR
| Shut Down Window:

g; ‘What do you want the computer to do?
@ {Shu dowr}

€ Restatt
€ Restartin MS-D0S mode

[ Concel |  Heo |

2. Click OK if you want to turn off your computer.

If your computer doesn’t turn off automatically, a message appears when you
can safely turn off your computer.
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CHAPTER 4

Customizing Your Desktop

Windows 98 provides endless possibilities for integrating your computer with the
Internet. Even if you don’t have an Internet connection or if you prefer the classic
Windows look, you can still take advantage of the Web-like features. For
example, now you can browse the World Wide Web or your hard drive from any
window by using single-click navigation. Or you can use Web pages as
backgrounds on your desktop and in individual windows.

Never before have so many choices for customizing Windows been available.
Create your own toolbar, from which you can easily open your favorite
applications or to which you can add your favorite links. Perform an Internet
search while browsing your hard drive in the same window. Have news topics that
interest you delivered automatically. View an electronic television program guide
and watch live Internet broadcasts.

Contents

Choosing a Desktop Style
Working in Web Style
Working in Windows 95 Classic Style
Choosing Custom Settings

Adding Browsing Tools
Using Toolbars
Using Explorer Bars

Delivering Web Content to Your Desktop
Using the Active Desktop
Displaying Web Content in Individual Windows
Displaying Web Content Automatically
Offline Reading
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Getting Started

Watching TV on Your Computer

Personalizing the Display Properties of Your Desktop
Customizing the Desktop for Multiple Users
Customizing the Start Menu and the Taskbar

Using Multiple Monitors

Choosing a Desktop Style

Windows 98 provides several ways to view your desktop and browse your files
and folders. You can choose between three different views—the Web style, the
classic Windows 95 look, or a combination of options. The view you choose
determines how you browse in Windows 98, regardless of whether you start from
the desktop, My Computer, Windows Explorer, or Internet Explorer.

Web style In this view, you can browse the desktop and folders like you
browse Web pages, by single-clicking items. In the Web-style view, files,
folders, and applications open in a single window, instead of in separate
windows.

Classic style This desktop view is similar to the classic Windows 95
desktop. You double-click to open items, and a new window appears for each
item you open.

Custom style You can also pick and choose which options you want.
Custom settings include options for browsing folders, creating window
backgrounds, and selecting and opening items. For example, you can use
options from both the Web style and the Classic style so that you double-click
to open items and use Web pages as window backgrounds.

For more information about changing your desktop style, look up “customizing
the desktop” on the Index tab in Windows Help.

Note The procedures in this book describe the double-click method of browsing.
Your computer manufacturer may have selected a different desktop style for your
copy of Windows 98. If you’re using the single-click option, point to an icon to
select a file and single-click the icon to open the file.




Chapter 4 Customizing Your Desktop 55

Working in Web Style

You can work in Web style if you prefer to organize and browse your computer
contents using the following Web-like options.

Single-click to browse the desktop and folders.

You click only once to open an item, just as you click a Web /ink to jump.
Similarly, you simply point to items to select them.

Show Web page backgrounds in individual windows.

You can display Web pages, or any HTML page, as background in a window.
In Web style, any folder with HTML content is displayed as a Web page, as
shown in the following illustration. An HTML page can include artwork,
Microsoft Office documents, multimedia, interactive forms, and so on. Some
windows—such as My Computer and Control Panel— come with a
background that displays a description of each feature when you point to its
icon.
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For more information about using Web content within a window, see
“Displaying Web Content in Individual Windows,” later in this chapter.
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» To select the Web-style browsing option
1. On the desktop, double-click My Computer.
The My Computer window appears.
. On the View menu, click Folder Options.

™~

The Folder Options dialog box appears.
3. Click the Web style option, and then click OK.
The Single-click dialog box appears.

GWNIVM | File Types |

I-Wndm Desktop Update —————— —7-———*——“1

| C Mebstyd

i Your computer ooks and acts kke the Web (e.g., single-click).
| € Classic style

} ‘Your computer defaults to Windows classic settings.

|

i

€ Custom, based on settings you choose:

ok | Cencel | amp |

4. Verify that Yes is selected, and then click OK.
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Working in Windows 95 Classic Style

The Classic style resembles the Windows 95 desktop. Using this option, you
double-click to open items, and each item opens in a separate window.
» To select the Classic-style browsing ¢ption
1. On the desktop, double-click My Computer.
The My Computer window appears.
. On the View menu, click Folder Options.
The Folder Options dialog box appears.
3. Click Classic style, and then click OK.

(5]

Folde Gptons

Gmﬂlv.aw | Fie Types |

[ Windows Desktop Update

|

j € Websyle |

| Your computer looks and acts ke the Web [e.g., single-cick). |
'Q ic styiel

‘Your computer defaults to Windows classic settings.

€ Custom, based on settings you choose: Levirgs.,

ok | ‘Concel | ooy |




58 Getting Started

Choosing Custom Settings

If you want a combination of the Web style and the classic Windows 95 style,
you can customize these settings. For example, you may want to customize your
desktop by double-clicking to browse (Classic style) and displaying the Active
Desktop (Web style).

» To customize browsing options
1. On the desktop, double-click My Computer.
The My Computer window appears.
2. On the View menu, click Folder Options.
The Folder Options dialog box appears.
3. Select Custom, based on settings you choose, and then click Settings.
The Custom Settings dialog box appears.

;} ('Enabhalwebfddedmﬂmnwdeskmo lomize l

| € Use Windows classic desktop

~ Browse folders as follows S
| @ Open each foldet in the same window !
| € Open each folder in its own window

1~ View Web content in folders =
@ For o folders with HTML content
| € Only fot folders where | select "as Web Page" (View menu)

- Chick items as follows ——— 7
| @ Single-click to open an item (point to select) |
& Undetline icon lilles consistent with my browser settings «
€ Undekne icon ties only when | point at them ‘
| € Double-clck to open an tem (single-click to selsct) {

e |

4. Select the options you want, and then click OK.
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Adding Browsing Tools

No matter what view you’re using, you can browse your computer and the
Internet more efficiently by using the optional browsing tools. You can add
toolbars and Explorer Bars to many windows.

Using Toolbars

You can display one or more customizable foolbars at the top of a window.
As you browse, Windows 98 detects the kind of information presented in the
window and automatically displays the appropriate toolbar buttons and menus.
You can also add the following toolbars to the taskbar.

Toolbar

Use to

Standard Buttons

Address Bar

Links

Quick Launch

Display buttons for commonly used commands, such as copying,
pasting, and deleting items; changing views; and browsing
backward and forward.

Open Web pages, programs, folders, or documents. By default,
the Address Bar shows your current location, whether it’s a folder
or a Web page. You can browse to another location by typing an
address—a URL, a path, or even a program name.

If you start typing a previously typed address, the AutoComplete
feature finishes the address for you.

Go to featured pages such as the Best of the Web site, or create
your own custom links,

Open Web browsing software, read e-mail, view channels, or
instantly bring your desktop to the front. You can easily add a new
toolbar button by dragging the program icon to the Quick Launch
toolbar.
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>

You can enlarge your
taskbar by dragging
its inside edge.

The following illustration shows the various toolbars you can display.

Address Bar Standard Buttons Links 5
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Select an item to view Networking Tasks
its description.
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Quick Launch

To display a toolbar in a window
1. On the desktop, click My Computer.
The My Computer window appears.

2. On the View menu, point to Toolbars, and then click the name of the toolbar
you want to display.

The toolbar appears below the menu bar.

To display a toolbar on the taskbar
1. Right-click a blank area on the taskbar.
A shortcut menu appears.
2. Point to Toolbars, and then click the name of the toolbar you want to display.
The toolbar appears on the taskbar.
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» To open a Web page or file by using the Address Bar

Toretumtoarecently 1.

visited site, right-click
the Back or Forward

button. On the listthat 2.

appears, click the site
you want to view.

On the desktop, click My Computer.
The My Computer window appears.
On the View menu, point to Toolbars, and then click Address Bar.

3. In the Address Bar, type the Internet address or path, and then press ENTER.

-Or-

. Right-click a blank area on the taskbar.

A shortcut menu appears.

. Point to Toolbars, and then click Address.
. In the Address Bar, type the Internet address or paih, and then press ENTER.

Using Explorer Bars

You can use a browsing tool called an Explorer Bar for quick and easy access to
search engines and your favorite Web sites. When you display an Explorer Bar,
the current window splits into two frames. The left frame is the Explorer Bar—it
displays Favorites, search engines, or links such as channels. The right frame
displays the contents of the current directory or Web page. When you click a link
in the Explorer Bar, the content appears in the right frame. This way, for example,
you can browse search results in the right frame while your search engine is still
available in the left frame. The following Explorer Bars are available in most
windows:

Search Presents several popular Internet search engines. You can select a
search engine, or you can use the Provider-of-the-day.

Favorites Displays items you’ve specified as your favorite files, folders,
channels, and Web sites.

History Lists previously viewed Web sites and files, grouped by daily and
weekly time periods.

Channels Shows the Channel Bar, which contains links to a content
provider’s Web site. A channel is a special way of receiving Internet content.
You can subscribe to specific channels that interest you—the channel provider
updates the content and delivers it to you.

All Folders Uses a tree structure to show the hierarchy of available drives
and folders. This Explorer Bar is available only in Windows Explorer.
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» To display an Explorer Bar
1. Open the window in which you want to use the Explorer Bar.
2. On the View menu, point to Explorer Bar, and then click the name of the
Explorer Bar you want to display.
The Explorer Bar appears in the left frame of the window.
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Delivering Web Content to Your Desktop

Through the Internet, you have access to a wealth of information, from up-to-the-
minute international news and weather to research results. One of the most
exciting capabilities of Windows 98 is its ability to integrate Web content. You
can display Web content anywhere in Windows 98, such as on the desktop or in
an open folder.
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Using the Active Desktop

To create your own By using the Active Desktop feature, you can display any Web page on your
Web pages, youcan  desktop without opening your Web browsing software. You can view one or more

use HTML editing of your favorite World Wide Web sites, or you can even add Web pages that you
:zﬂwar%s;cha:)s create. Using the Active Desktop Gallery on the Microsoft Web site, you can also
E;;rr(;ss(; foniage add live content, such as an MSN™ Investor Ticker and the MSNBC Weather

page, to your desktop.

Either way, the Active Desktop makes your workspace far more functional,
regardless of which desktop view you're using. On your Active Desktop you can
display:

= Live, updated information, such as weather reports, stock ticker results, sports
scores, or server status.

= A page on your company intranet.
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=« An Office document, with active links.
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= A common desktop between computers, even over a network or the Internet.
= A Web-based search engine.
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Windows 98 comes with several items that you can try out on your Active
Desktop. For example, if you add the Channel Bar to your Active Desktop, you
can quickly access the Web contents provided by your favorite channels.

For more information about changing your Active Desktop, look up “Active
Desktop” on the Index tab in Windows Help.

To show or hide Active Desktop
1. Right-click a blank area on the desktop.
A shortcut menu appears.
2. Point to Active Desktop, and then click View As Web Page.

A check mark appears next to your selection if Web content can appear on the
desktop.

Note What you see on your Active Desktop varies depending on how
Windows 98 is set up—your computer manufacturer may have provided a unique
Active Desktop.

To add an Active Desktop item
1. Right-click a blank area on the desktop, and then click Properties.
The Display Properties dialog box appears.

2. Click the Web tab, and verify that the View my Active Desktop as a web
page check box is selected.

3. Click New.

4. If you want to add live desktop items, such as a stock ticker or news headlines,
click Yes to visit the Microsoft Active Desktop Gallery Web site; otherwise,
click No.

The New Active Desktop Item dialog box appears.

5. Type the location in the Location box, or click Browse to locate the item, and
then click OK.

The item is added to your Active Desktop.

To refresh Web content on the Active Desktop
1. Right-click a blank area on the desktop.
A shortcut menu appears.
2. Point to Active Desktop, and then click Update Now.
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Displaying Web Content in Individual Windows

Just as you can display a Web page on your desktop, you can also display a Web
page in an individual window. If you subscribe to the Web page, it can be
automatically updated on a regular basis. For example, using this Web integration
feature you can monitor weather, game scores, stock prices, or headlines—all in
the window of your choice.

If you select art or a Web page as window background, you need to view that
window as a Web page. That is, to display the background, you need to use Web
style—or select the As Web Page option on the View menu.

» To add a background to a window
1. Double-click My Computer.
The My Computer window appears.
2. Open the folder you want to customize.

3. On the View menu, click Customize this Folder, and then follow the
instructions in the Customize this Folder wizard.

» To display a folder as a Web page
1. Double-click My Computer.
The My Computer window appears.
2. Open the folder you want to view as a Web page.
3. On the View menu, select as Web Page.
A window background appears.
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Displaying Web Content Automatically

You can automatically receive timely news and information from the World Wide
Web. Content from Web pages can be delivered to your desktop through a
subscription or a chanrel.

Subscriptions

A subscription is invaluable if you frequently visit certain Web sites looking for
new content. Web site subscriptions work much like magazine subscriptions—
you are notified periodically of new content, according to a schedule that you set
up. If you want, you can have Windows 98 automatically deliver the new content
to your computer. For example, you can schedule the latest financial news to be
automatically downloaded every night while you sleep, and it will be ready for
you in the morning.

You can subscribe to any Web page that you visit. When you subscribe to a Web
page, you'll need to decide if you want the new Web pages automatically
downloaded to your computer. You can save connection time and expense by
having your subscriptions downloaded so that you can read them offline later at
your leisure. Or if you don’t want the information downloaded to your computer,
you can be notified in the following ways when new content is available:

E] = Smart Favorites Your subscription is automatically checked for updates —
the icon changes if the page is updated. You can view the icons for your
subscriptions in the Subscriptions folder.

» E-mail notification A copy of updated Web pages with live links to the
World Wide Web can be automatically sent to you by e-mail.

» To subscribe to a Web site

1. In the My Computer window, go to the Web page to which you want to
subscribe.

2. On the Favorites menu, click Add to Favorites.
The Add Favorite dialog box appears.

3. Select Yes, but only tell me when this page is updated or Yes, notify me of
updates and download the page for offline viewing.
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4. Click Customize to see subscription options.
The Subscription wizard starts.

Intemet Exploret notifies you if the page has
2 changed by adding a red gleam to s icon.
Would you also ke to be notified in an e-mai message?

© g

€ Yes, send an e-mad mezsage to the following address:

5. Follow the instructions in the Subscription wizard.

» To update subscriptions to all Web sites
1. Double-click My Computer.
The My Computer window appears.
2. On the Favorites menu, click Update All Subscriptions.

» To view your subscriptions
1. Double-click My Computer.
The My Computer window appears.
2. On the Favorites menu, click Manage Subscriptions.

The Subscriptions window starts, with a list of your subscriptions. In this
window, you can delete, update, or modify your subscriptions.

Channels

If subscriptions work like magazine subscriptions, then channels are similar to TV
channels. Instead of receiving periodic updates of Web sites, your computer has
access to content that’s always available. A channel is a Web site that’s designed
to deliver content to you—the content provider specifies what Web content is
delivered and how often.
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To view the content in a channel, you can click one of the channel buttons on the
Channel Bar. The Channel Bar displays all channels installed on your computer.
You don’t have to subscribe to a channel to view it, but you'll add the channel
button to the Channel Bar if you do subscribe, making the content readily
available. Some content providers allow you to preview their entire Web site
without a subscription, while other sites require that you first subscribe. You can
view channels in many places—on the desktop, in windows, and even in a special
screen saver.

» To view channels
1. In the My Computer window, on the Favorites menu, point to Channels.
A list of available channels appears.

2. Point to a channel, and then click a topic.
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» To add the Channel Bar to your desktop
1. Right-click a blank area on the desktop, and then click Properties.
The Display Properties dialog box appears.
2. Click the Web tab.
3. Select the View my Active Desktop as a web page check box.

A check mark indicates that the check box is selected.
4. Select the Internet Explorer Channel Bar check box.
5. Click OK.

The Channel Bar is added to your desktop.
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» To view the Channel Bar in a window
= In any Internet Explorer window, click the Channels button.

You can also click the View Channels button on the taskbar.
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Reading Web Content Offline

U

You can cut down on your Internet connection time by reading Web content
offline. At any time, you can save a copy of the current Web page for later
reading—even after you’re no longer connected to the Internet. If you're
browsing Web pages while offline, the mouse pointer indicates that links are
not available.

» To browse a Web page offline
1. Go to the Web page you want to read offline.
2. On the File menu, click Work Offline.

A check mark appears next to your selection, indicating that you're
disconnected from the Internet, and the current Web page is stored on your
computer. Repeat these steps to reconnect to the Internet and browse online.
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Watching TV on Your Computer

Windows 98 supports cable or broadcast TV. From your desktop, you can watch
your favorite TV shows, search through program schedules, and be reminded
when your favorite shows are on. You don’t have to have an Internet connection
to use WebTV for Windows, but your computer has to have a compatible TV
tuner card. Using WebTV for Windows, you can view the online Program Guide,
which offers TV channel listings, previews, interactive features, TV schedule
searching, and one-click VCR programming.
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WebTV for Windows is an optional feature, so you may first have to install it.

» To install WebTV for Windows
1. Click the Start button, point to Settings, and then click Control Panel.
Double-click Add/Remove Programs.
Click the Windows Setup tab.
Select WebTV for Windows, and then click OK.

Follow the instructions that appear on your screen.

AR
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» To start WebTV for Windows

= Click the Start button, point to Programs, point to Accessories, point to
Entertainment, and then click WebTV for Windows.

é’:‘ For more information about using WebTV for Windows, start WebTV for
3 Windows and press Fl.

Personalizing Your Desktop Display

In addition to customizing your computer by using the TV and Web-like options,
you can personalize your desktop with pictures, patterns, and colors by using the
Display control panel. You can display pictures, patterns, or even scanned
photographs as your wallpaper, the background of your desktop. Using the
different tabs in the Display Properties dialog box, you can also change items
such as the icons on your desktop, the colors of individual windows, and the size
of the objects on your screen. You can even add items to your Active Desktop or
set up a screen saver.

» To open the Display control panel
1. Click the Start button, point to Settings, and then click Control Panel.
The Contro! Panel window appears.
2. Double-click Display.

The Display Properties dialog box appears. To set wallpaper, select an image
or click the Browse button. Click the other tabs in the dialog box to set up a
screen saver, change the desktop and window colors, add Active Desktop
items, change your screen resolution, and so on.
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Customizing the Desktop for Multiple Users

You can set up different desktop configurations, or profiles, if more than one
person uses the same computer. Each person logs on to Windows and sees his or
her own customized settings, including desktop settings, programs, Start menu,
and Favorites. Because each user has a unique profile of settings, if one person
makes changes, it doesn’t affect another user’s profile. Before you can use
profiles, you must first set up a unique user name and password for each user.

» To set up a user profile
1. Click the Start button, point to Settings, and then click Control Panel.
The Control Panel window appears.
2. Double-click Users.
The Enable Multi-User Settings wizard starts.
3. Follow the instructions in the wizard.
Repeat this process for each user’s personalized settings.
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Customizing the Start Menu and the Taskbar

You can rearrange You can customize the Start menu to help you work more efficiently. You can add

items on the Start folders or files that you open frequently, so that you can open them quickly from

menu by dragging the Start menu at any time. Or you can create your own groups of files and

|tem§ to another rograms. You can also add items to or remove them from the Start menu. For
prog

location on the Start

example, you can reduce the size of the Start menu by removing a program that

menu. | ?
you no longer use.

If you remove an item from the Start menu, you’re not uninstalling the program or
removing it from your computer. For more information, see “Adding and
Removing Programs™ in Chapter 3, “Using Your Desktop.”
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You can customize
your Start menu.

» To customize the Start menu

1. Click the Start button, point to Settings, and then click Taskbar & Start
Menu.

The Taskbar Properties dialog box appears.
. Click the Start Menu Programs tab.

W

. Click Add or Remove, and then follow the instructions that appear on the
screen.



Chapter4 Custemizing Your Desktop 75

To set the date and
time, double-click the
clock on the right end
of the taskbar.

You can also customize the taskbar to suit your needs. The taskbar is located at
the bottom of the desktop by default, but you can drag it to any side of the
desktop. You can also hide the taskbar until you want to use it, or you can always
display the taskbar on top of other windows.

To customize the taskbar

1. Click the Start button, point to Settings, and then click Taskbar & Start
Menu.

The Taskbar Properties dialog box appears.
2. Select the taskbar options you want.

To move the taskbar
= Drag the taskbar to any edge of the desktop.

For information about adding toolbars to your taskbar, see “Using Toolbars,”
earlier in this chapter.

Using Multiple Monitors

With Windows 98, you can connect up to nine monitors to your computer. You
can set up these monitors like one large desktop, or you can set them up to show a
different program on each monitor. For example, you could have a financial report
open in Word on one monitor, have a quarterly budget spreadsheet open in
Microsoft Excel on another monitor, and refer to the budget while you write the
report.

To set up multiple monitors, you must have a PCI graphics adapter for each
monitor you want to connect to your computer. The multiple monitor feature
supports only PCI graphics adapters at this time.

With your computer off, install the PCI graphics adapters in your computer,
connect a monitor to each, and turn on your computer. Windows 98 detects the
multiple graphics adapters and prompts you through their setup.

Note If you’re unsure how to install a PCI graphics adapter, or if your warranty
will be voided by installing your own hardware, you should contact an authorized
service center to install it for you.
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You can change the settings for each monitor in the Settings tab of the Display
control panel. Your primary monitor will be the one connected to the graphics
adapter in the first open PCI slot.

Note You don’t need to install Windows 98 before you install the multiple
graphics adapters. Windows 98 will detect them during the initial setup. However,
if you have a graphics adapter built into your motherboard, you must install
Windows 98 first, and then any additional graphics adapters. If you don’t,
Windows 98 might not detect the graphics adapter on your motherboard.

é For more information about multiple monitors, look up “multiple display support”
on the Index tab in Windows Help.
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Advanced Issues

This chapter covers a wide variety of topics, ranging from using the online
troubleshooters to connecting to printers and networks. You can read about
backing up files, the FAT32 file system, disk defragmentation, and more. You'll
also find a list of answers to some common questions, such as what Active
Desktop and Channels are.

Contents
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Backing Up Files Before Installing Windows 98
Backing Up Files After Installing Windows 98
Using the Startup Disk
Uninstalling Windows 98
Using the FAT32 File System
Understanding How Information Is Stored
Converting to FAT32
Defragmenting Your Hard Disk
Using Your Computer on a Network
Connecting to a Network
Sharing Folders and Printers
Using Dial-Up Networking
Internet Setup
Setting Up an Internet Connection
Setting Up E-mail, Newsgroups, and Internet Directory Services
Configuring Your Internet Connection
Logging On Manually to an ISP
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Printing
Setting Up a Printer
Determining the Default Printer
Printing a Document
Frequently Asked Questions
Printing
Desktop Options
The Internet
General Issues

Using Troubleshooters

If you're having a problem with your hardware or software, first check the
troubleshooters available in Windows Help. The extensive troubleshooters help
you diagnose common problems and determine how best to fix them.

Updated and additional troubleshooters are available on the Support Online Web
site.

Note To see the latest troubleshooting information, you can connect to Support
Online by clicking the Web Help button in Windows Help or by connecting to
http://support.microsoft.com/support/

In the troubleshooters, you can find information about topics such as:

= Networking

= Modems

= Startup and Shutdown
= Printing

= DriveSpace 3

=  Memory

= MS-DOS programs

= Display

= DirectXe

»  Sound



Chapter5 Advanced lssues 78

s The Microsoft Network

= Hardware Conflicts

» Dial-Up Networking

s Direct Cable Connections
s PC Cards

To open a troubleshooter in Windows 98 Help
1. Click Start, and then click Help.

2. On the Contents tab, click Troubleshooting, click Windows 98
Troubleshooters, and then click the topic you want.

Maintaining Your Computer

You can use the Maintenance wizard to check your hard disk for problems,
manage hard disk space more efficiently, delete unnecessary files, and make
your programs run faster. The Maintenance wizard combines the functions of
ScanDisk, Disk Cleanup, Disk Defragmenter, Compression Agent, and other
tools in one easy-to-use feature. You can even schedule these tasks to run on a
regular basis.

Note You can use Compression Agent to compress files only on drives
compressed using DriveSpace 3. For more information, see “DriveSpace 3" on the
Index tab in Windows Help.

To start the Maintenance wizard

¢ Click Start, point to Programs, point to Accessories, point to System Tools,
and then click Maintenance wizard.

The Maintenance wizard starts. Follow the instructions on your screen.

For more information about power management features, look up “power
management” on the Index tab in Windows Help.
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Backing Up Your Files

How you back up your files depends on your current operating system.

Backing Up Files Before Installing Windows 98

Before installing Windows 98, you should back up your current files. The
following procedures describe how to back up your files from Windows 3.1 and
Windows 95. If you’re currently using another operating system, you should see
its documentation for information about backing up files.

Backing up your files in Windows 3.1

Before backing up your files, be sure the Windows Backup tool is installed on
your computer. To do this, open the Microsoft Tools program group. If the
Backup icon is present, Windows Backup is already installed.

If there is no Microsoft Tools program group, or if it doesn’t include the Backup
icon, you need to install the Backup tool. Because the Windows Backup tool is
installed during MS-DOS Setup, reinstall MS-DOS and select Windows Backup
when prompted.

» To back up files in Windows 3.1
1. In the Microsoft Tools program group, double-click Backup.

If this is the first time you’ve used Microsoft Backup, you’re prompted to
configure it before performing your first backup. Click Yes. During the
configuration process, Backup automatically creates a test backup of your
MS-DOS folder. Follow the prompts to complete the test backup.

. In the Microsoft Backup dialog box, click Backup.
. In Backup From, select the source drive (the drive you want to copy from).
. In Backup To, select the destination drive (the drive you want to copy to).

w oA wWN

. To select all files on the drive, double-click the drive letter in Backup From.
To select specific files or folders for backup, click Select Files.
= Double-click any folder you want to back up.
-Or-

= To back up individual files in a folder, click the folder once, and then right-
click each file you want to back up.

6. Click OK when you're finished.
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7. In Backup Type, select a backup type. Click Help, and then click Backup
for an explanation of each backup type.

8. Click Start Backup to begin the backup process, click OK, and then follow
the instructions that appear on your screen.

For more information about Backup, see Windows 3.1 online Help.

Backing up your files by using Windows 85

Before backing up your files, be sure that the Windows 95 Backup tool is )
installed. If Backup appears in Add/Remove Programs in Control Panel, you can
skip this procedure and begin backing up.

To install the Backup program in Windows 95
1. Click Start, point to Settings, and then click Control Panel.

2. Double-click Add/Remove Programs, click the Windows Setup tab, and
then select Disk Tools.

3. Click Details, select Backup, click OK, and then click OK again.
4. Insert your Windows 95 Setup disk or CD when prompted, and then click OK.

To back up files in Windows 95

1. Click Start, point to Programs, point to Accessories, point to System Tools,
and then click Backup.

2. Read the information in the Welcome to Microsoft Backup dialog box, and
then click OK.

Microsoft Backup starts.

3. Read the Full System Backup information, and then click OK.

4. Select each item you want to back up. To see folder contents, click the plus (+)
sign to the left of each folder.

5. Click Next Step.

6. Select the device on which you want to store the backup files. For example, if
you have a tape drive, click the tape drive icon.

7. Make sure you have a tape or disk in the backup drive, and then click Start
Backup.

8. When prompted for a Backup Set Label, type a name for the backup. You can
also set a password. Click OK.

A message indicates when Backup is complete. If any errors occur during Backup,
they’re noted in the lower left of the Backup dialog box.
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Backing Up Files After Installing Windows 98

In Windows 98, you can use Microsoft Backup to back up your files to floppy
disks, a tape drive, a removable storage device, or another computer on your
network. If the data on your hard disk is damaged, you can restore copies of your
files from your backup.

You can back up all of the files on your computer, or you can select specific
folders and files to back up. It’s recommended that you back up your files on a
regular basis. If your hard disk is damaged, you’ll be able to retrieve information
you backed up.

|§ For more information about the Backup program, look up “Backup” on the Index
tab in Windows Help.

Note For a list of hardware that’s compatible with the Backup feature, visit the
Microsoft Hardware Compatibility List Web page at
http://www.microsoft.com/hwtest/hcl

» To install the Backup program in Windows 98

1. Click Start, point to Settings, click Control Panel, and then double-click
Add/Remeove Programs.

The Add/Remove Programs Properties dialog box appears.
2. Click the Windows Setup tab, and then select System Tools.
3. Click Details, select Backup, click OK, and then click OK again.
4. Insert your Windows 98 Setup disk or CD when prompted, and then click OK.

» To back up files in Windows 98

1. Click Start, point to Programs, point to Accessories, point to System Tools,
and then click Backup.

The Microsoft Backup dialog box appears.
2. Follow the instructions on your screen.
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Using the Startup Disk

If you have problems with Setup or have trouble starting Windows 98, you can
use a Startup Disk to start your computer and run Setup or to gain access to your
system files. If you have problems with your hard disk, for example, you can use a
Startup Disk to start your computer and troubleshoot your hard disk.

You're prompted to create a Startup Disk during Setup. If you want to create
another Startup Disk after you install Windows 98, you easily can. You can even
save a specific startup configuration on a disk. For example, you can save the
specific drivers for your computer on a Startup Disk.

The Startup Disk contains generic CD-ROM drivers, which you can use if your
computer has difficulty communicating with your CD-ROM drive. To use these
drivers, select the CD-ROM drive option.

Important Startup disks created with previous versions of Windows aren’t
compatible with Windows 98.

» To create a Startup Disk from within Windows 98

1. Click Start, point to Settings, click Control Panel, and then double-click
Add/Remove Programs.

The Add/Remove Programs Properties dialog box appears.
2. Click the Startup Disk tab, and then click Create Disk.

3. Label a floppy disk “Windows 98 Startup Disk,” insert it into your floppy disk
drive, and then click OK.

» To start your computer using a Startup Disk
1. Insert the Startup Disk in the floppy disk drive.
2. Restart your computer.
The Microsoft Windows 98 Startup menu appears.
3. Type the number of the appropriate CD-ROM option, and then press ENTER.
4. Follow the instructions on your screen.

After a series of scans, the MS-DOS prompt appears. From this prompt, you
can gain access to the system files on the Startup Disk. For information about
running Setup from a Startup Disk, see Chapter 2, “Installing Windows 98.”

Note If you normally use a CD-ROM drive and you start your computer with
a Startup Disk, the drive letter designated to the CD-ROM may change for that
session. For example, if your CD-ROM is normally drive D, it might be
temporarily changed to drive E.
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Uninstalling Windows 98

During the upgrade from an earlier version of Windows to Windows 98, you have
the option of saving your old system files. If you save your system files, you can
uninstall Windows 98 and restore your earlier version of Windows.

Important This recovery capability is available only if you don’t compress the
hard disk on which Windows 98 is installed.

To uninstall Windows 98

1. Click Start, point to Settings, click Control Panel, and then double-click
Add/Remove Programs.

2. On the Install/Uninstall tab, click Uninstall Windows 98, and then click
Add/Remove Programs.

3. Click Yes, and then click Yes again.

Your hard disk is checked for errors.
4. After the disk check is complete, click Yes to continue.

Your computer restarts, and your previous version of Windows is restored.
5. Remove any floppy disks, and then press ENTER when prompted.

Your previous version of Windows starts.

Using the FAT32 File System

When you save files, your computer uses a file system to control how your files
and folders are stored on your hard disk. Earlier versions of MS-DOS and
Windows use the FATI16 file system exclusively. Windows 98 uses FAT16 by
default, but you have the option of using FAT32, an enhanced file system that can
improve disk performance and increase available disk space.

Understanding How Information Is Stored

When you save a file or install a program, your computer stores the information
on your hard disk in small areas called clusters. The smaller the cluster size you
use, the more efficiently your disk stores information. Cluster size depends on the
size of your partition, and partition size depends on the file system you use. By
default, most computers use just one partition.

For information about dividing your disk into partitions, consult the Windows 98
Resource Kit.
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The table below illustrates the larger partition size and smaller cluster size
available through the FAT32 file system. Partitions larger than 2 gigabyte (GB)
are not supported with FAT16, and partitions smaller than 512 MB are not
supported with FAT32.

Partition size FATI6 cluster size FAT32 cluster size
32 MB (megabytes) 2 KB (kilobytes) —
128 MB 2KB —
256 MB 4KB —
512MB 8 KB 4KB
1 GB (gigabyte) 16 KB 4KB
2GB 32KB 4KB
3GB-7GB _ 4KB
8 GB- 16 GB — 8KB
16 GB- 32 GB — 16 KB
Larger than 32 GB — 32KB

If your hard disk is smaller than 2 GB and your computer uses the FATI6 file
system, you may not see much improvement if you convert to FAT32. But you
may want to convert to FAT32 if your hard disk is between 2 GB and 2 terabytes
(TB) and you want to improve its efficiency.

The FAT32 file system has the following advantages over FAT16:

= It allows programs to open more quickly, on average, 36% faster.

= [t uses a smaller cluster size, resulting in more efficient use of disk space—on
average, 28% more disk space.

s [t allows a hard disk of up to 2 TB to be formatted as a single drive,
eliminating the need to partition the hard disk.

= It can relocate the root directory and use backup copies of the FAT, making
your computer less vulnerable to crashes.
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Converting to FAT32

You can use the FAT32 conversion tool to easily convert your hard disk to the
FAT32 file system. However, before you convert file systems, you should read the
following information carefully:

If you didn’t make a Windows 98 Startup Disk, you should create one by
following the steps in the “Using the Startup Disk” section earlier in this
chapter before you convert to FAT32.

You shouldn’t convert any drives on which you also want to run an operating
system that doesn’t support FAT32. Also, if you’re running Windows 98 and
another operating system in a dual-boot environment, converting your primary
disk drive to FAT32 may cause the other operating system to be unusable. This
is true even if the other operating system is installed on a different drive.

If anti-virus software is running, it may detect the request to update the
partition table and boot record and prompt you to allow the updates. If this
occurs, instruct the anti-virus software to allow the updates.

Once you convert to FAT32, you can’t compress stored information or convert
back to FAT16 unless you use a third-party partition management utility
designed for that purpose.

If you have a removable disk that you use with another operating system, don’t
convert to FAT32.

Hibernate features may not work on a FAT32 drive. Hibernate features are
those that allow some computers to enter a suspend state, with all power turned
off.

If you convert your hard drive to FAT32, you cannot uninstall Windows 98.
Although most programs are not affected by the conversion from FAT16 to
FAT32, some older disk utilities that depend on FAT16 don’t work with

FAT?32 drives. Contact your disk utility manufacturer to see if there is an
updated version that is compatible with FAT32.

A FAT32 drive can be shared across a network by MS-DOS, Windows 3.1,
Windows 95, Windows NTe Workstation version 4.0, and Windows NT Server
version 4.0. In addition, MS-DOS version 7.1 (the version that ships with
Windows 98) also supports FAT32.
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» To convert your file system to FAT32

L.

Click Start, point to Programs, point to Accessories, point to System Tools,
and then click Drive Converter (FAT32).

2. Click Next when you’ve finished reading the information.

3. In Drives, click the drive to be converted, and then click Next.

A message appears, reminding you that previous versions of MS-DOS,
Windows, and Windows NT can’t gain access to FAT32 drives.

. Click OK to continue, or click Cancel to quit the Drive Converter wizard.

The Drive Converter wizard searches for anti-virus programs or disk utilities
that are incompatible with FAT32. If the wizard finds any incompatible
programs, you can click Details to display a description of the problem. If no
incompatible programs are found, click Next.

. If you want to back up your files before converting to FAT32, click Create

Backup. If you don’t have the Windows 98 Backup program installed, you’re
prompted to install it.

. When you’re ready to continue, click Next, and then click Next again.

Your computer restarts, and the conversion begins. It may take an hour or
more to complete the defragmentation and conversion processes on large or
very full drives.

After the conversion completes, a message appears telling you whether the
conversion was successful or unsuccessful.

Caution Your anti-virus software may detect that the partition table and boot
record have changed and offer to “repair” them for you. Don’t perform this
repair. If you do, your computer boot record or partition table will be changed,
and your drive and all of the data on it may become inaccessible.

. If the conversion was successful, click Finish. The conversion is complete.

If the conversion was unsuccessful, a message explains why the conversion
failed.
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Defragmenting Your Hard Disk

The Disk Defragmenter utility rearranges the data on your disk so that each file is
stored in contiguous blocks, rather than being scattered across different areas of
the disk. This defragmentation of stored information helps to speed disk
performance. The time required for defragmentation depends on the size of your
hard disk and the amount of data on the disk.

To defragment your hard drive

1. Click Start, point to Programs, point to Accessories, point to System Tools,
and then click Disk Defragmenter.

2. In the Select Drive dialog box, select the hard disk you want to defragment.
3. Close any open programs, and then click OK.
Defragmentation begins.

Using Your Computer on a Network

This section describes how to connect your computer to a network, share folders
and printers, and use the Dial-Up Networking feature.

For information about connecting to the Internet, see “Internet Setup,” later in this
chapter.

Connecting to a Network

If the Network A network is made up of client and server computers. A computer that connects to
Neighborhood icon the network and uses shared resources is called a client. A central computer that

is on your contains shared information is called a server. This section explains setting up a
Windows 98 desMop,  cjient computer.

your network

connection isalready  To connect to a network, you reed the correct hardware installed in your

setup, and you can computer. This includes a network adapter (network card or other device) and

skip this section. cables.

Along with additional hardware, your computer must have certain software
components to communicate with the network. Software needed to connect a
computer to a network includes the following:

« Client software, which allows your computer to connect to servers.

= A protocol, which is essentially the language your computer uses to
communicate over the network. Several protocols are available. Two
computers must use the same protocol to communicate with each other.

s Service software, which allows such functions as file and print sharing.
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Before proceeding, you need to know which types of software to use. Ask your
network administrator about client software and configuration options.
Windows 98 also automatically detects and installs the other components you
need in order to connect to the network. Windows 98 also automatically detects
and installs TCP/IP networks during setup.

If you’re connecting to another type of retwork, or if you're not connecting
during Windows 98 installation, use the following procedure. This procedure
assumes that your computer is already physically connected to the retwork—for
instance, by network cable. You can also connect computers by serial or parallel
cable.

For more information about individual connections, look up “Direct Cable
Connection” on the Index tab in Windows Help.

To connect your computer to a network

1. Click Start, point to Settings, click Control Panel, and then double-click
Network.

2. In the Network dialog box, click Add.
3. Click Client, and then click Add.
A list of client software appears.

4. In the Manufacturers list, click the name of the manufacturer of your network
software.

5. In the Network Clients list, select the client software you are using, and then
click OK.

The client software is added to your computer.
6. On the Configuration tab, select your client, and then click Properties.
7. Enter the configuration options for your network, and then click OK.

If you don’t know the options for your network, contact your network
administrator.

8. Click OK, and then click OK again,
The client software is installed and your computer restarts.
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Sharing Folders and Printers

You can also use this
procedure to share an
entire disk drive.
Instead of selecting a
folder, select a drive
icon.

If you set up a Microsoft or Novell network client, you can share your
documents—and any printers attached to your computer—with other people

on the network. To use file and print sharing, you must first choose which of two
types of access you want to give other users.

» Share-level control is the default access setting. It lets you require a password
for each shared resource.

= User-level control lets you specify who has access to each shared resource, but
it does not let you require a password.

To change from share-level control to user-level control

1. Click Start, point to Settings, click Control Panel, and then double-click
Network.

2. Click the Access Control tab, and then click User-level access control.

3. In Obtain list of users and groups from, type the name of the domain or
server you want to use, and then click OK.

You may be prompted to supply additional information about the domain or
server you specified.

4. Restart your computer.

To set up file- and print-sharing services

1. Click Start, point to Settings, click Control Panel, and then double-click
Network.

2. In the Network dialog box, click File and Print Sharing.

3. Select the check box(es) for the sharing options you want, click OK, and then
click OK again.

A message prompts you to insert your Windows 98 CD or Setup disks so that
File and Print Sharing can be installed. You must restart your computer before
the new sattings will take effect.

After you’ve set up file- and print-sharing services, you can share a folder or
printer.

To share a folder with share-level access control

1. In My Computer, right-click the folder you want to share, and then click
Sharing.

2. In the Properties dialog box, click the Sharing tab, and then click Shared As.
3. In Share Name, type a name for the folder.
In Comment, you can type a brief comment or description of the folder.
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. In Access Type, click Read Only, Full, or Depends on Password.

Regardless of which type of access you select, you have the option of adding a
password.

. Type a password if you want to use one, and then click OK.
. Retype the password, and then click OK.

The folder or printer icon changes to a folder or a printer with a hand,
indicating that the item is now shared.

To share a folder with user-level access control

In My Computer, right-click the folder you want to share, and then click
Sharing.

. On the Sharing tab, click Shared As.
. In Share Name, type a name for the folder.

In Comment, you can type a brief comment or a description of the folder.

4. Click Add.

7.

. In the Add Users dialog box, click the name(s) of the person(s) to whom you

want to grant permissions.

You can scroll the list of users, or you can simply type the name and the list
will scroll automatically. If you want to grant the same permissions to
everyone connected to your network, leave The World selected.

. Click the type of access permissions you want to give the selected user(s).

Read Only means the user has the ability to read, but not change, files.
Full Access means the user has the ability to read, delete, and change files.
Custom means the user has a combination of privileges that you specify.
‘When you’re finished adding users and permissions, click OK.

To share a printer with share-level access control

L.
2. Right-click the printer you want to share, and then click Sharing.
3.

4. In Share Name, type a name for the printer.

In My Computer, double-click the Printers folder.
On the Sharing tab, click Shared As.

In Comment, you can type a brief comment or a description of the printer.
In Password, you can type a password that a user must type to use the printer.

. Click OK.

If you typed a password, retype the password to verify it. Click OK.
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» To share a printer with user-level access control

1.

(3]

8.

In My Computer, double-click the Printers folder.

2. Right-click the printer you want to share, and then click Sharing.
3.
4. In Share Name, type a name for the printer.

On the Sharing tab, click Shared As.

In Comment, you can type a brief comment or a description of the printer.

. Click Add.
. In the Add Users dialog box, click the name(s) of the person(s) to whom you

want to grant permissions.

You can scroll the list of users, or you can simply type the name and the list
will scroll automatically. If you want to grant the same permissions to
everyone connected to your network, leave The World selected.

. Click Full Access.

The name(s) of the person(s) you have chosen will be moved to the box on the
right side of the screen.

When you're finished adding users and permissions, click OK.

Using files and printers controlled by other computers
If you have correct permissions, you can use files and printers that are shared on
other computers.

» To use a shared folder or printer

1.
2.

Double-click Network Neighborhood.

Double-click the icon for the computer that controls the folder or printer you
want to use.

If the computer you are looking for is not in your workgroup or domain, first
click Entire Network, and then double-click the appropriate workgroup or
domain.

. To use a shared folder or printer, double-click its icon.
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Using Dial-Up Networking

If the Dial-Up
Networking icon
doesn't appear in the
My Computer window,
you must install the
component.

You can use a phone line and your modem to connect to your office network or an
Internet service provider (ISP). By using Dial-Up Networking, you can use any
shared resource (such as e-mail or a folder) to which you have access.

For you to connect two computers through Dial-Up Networking, both computers
must have modems installed, both computers must have Dial-Up Networking set
up, and the computer to which you want to connect must be set up as a server.

If there’s no Dial-Up Networking icon in the My Computer window, you can use
the following procedure to install it.

To install Dial-Up Networking

1. Click Start, point to Settings, click Control Panel, and then double-click
Add/Remove Programs.
2. Click the Windows Setup tab, click Communications, and then click
Details.

3. Select the Dial-Up Networking check box, and then click OK. Click OK
again, and then follow the instructions that appear on your screen.

Important After you install Dial-Up Networking on the computer you want to dial
into, be sure to share the folders you want to use.

With Dial-Up Networking you can create an individual icon for each phone
number you call. For example, you could have an icon for your employer’s server
and one for MSN. When you set up a new connection, an icon is created in the
Dial-Up Networking folder.

To create a connection
1. Double-click My Computer, and then double-click Dial-Up Networking,

2. Double-click Make New Connection, and then follow the instructions in the
Dial-Up Networking wizard.

The behavior of each connection is controlled by the properties of the icon.
To view or modify these properties, right-click the icon, and then click Properties.
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The Server Types tab should indicate the server this connection will dial, as
specified by your network administrator. The following settings usually work:

= The default setting, PPP, is correct for most servers, including most Internet
servers and newer Netware servers.
= If you’re connecting to an older Netware server, select NRN.

« If you're connecting to a Unix network, select CSLIP or SLIP, as directed by
the network administrator.

= If you’re connecting to a Windows for Workgroups or Windows NT 3.51
server, select that server type.

For most connections, the default settings on the rest of the tab are correct.

For more information about networking, look up the following topics in Windows
Help:
= “Dial-Up Networking” on the Index tab.

= “Dial-Up Networking” under Troubleshooting, Windows 98 Troubleshooters
on the Contents tab.

« “Modem” under Troubleshooting, Windows 98 Troubleshooters on the
Contents tab.

Setting Up an Internet Connection

Using the Internet Connection wizard, you can quickly set up an Internet account
and connection. After you set up a connection, you can also use the wizard to set
up e-mail, newsgroups, and directory services.

To connect to the Internet, you need a modem or you need to have a network card
installed in your computer. When you have a modem, you connect to the Internet
through your phone line. When you have a network card, you connect through the
network cable system.

If you’re connecting via modem, you sign up with an Internet service provider or
an online service. An Internet service provider (ISP) is a company that provides
Internet connections. An online service—a subcategory of ISPs— provides the
Internet connection and many additional services. Well-known online services
include The Microsoft Network (MSN) and America Onlines (AOL).
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Using the Internet Connection Wizard

If your computer isn’t connected to the Internet, the Connect to the Internet icon
appears on your desktop. You can start the wizard by simply double-clicking
Connect to the Internet, or you can use the procedure below.

» To start the Internet Connection wizard

= Click Start, point to Programs, point to Internet Explorer, and then click
Connection Wizard.

The Internet Connection wizard starts.

The wizard’s second screen offers three connection options. Read the section that
applies to your situation and follow the instructions in the wizard.

Option 1: Setting up a new Internet account

When you use the Internet Connection wizard to set up a new ISP, the wizard
retrieves a list of providers from the Microsoft Internet Referral system. You can
then click the name of an ISP, and you’ll see a page with more information about
that ISP.

Option 2: Connecting to an existing Internet account

Use this option if you’ve already set up an account with an ISP, but you’ve never
connected using this computer. This includes using a local area network (LAN),
such as your employer’s network, for your Internet connection. If you want to set
up a connection through a local area network, contact your retwork administrator.

Option 3: Don't show the Internet Connection wizard again
Use this option if you’ve already set up an Internet connection on your computer.

Setting Up E-mail, Newsgroups, and Internet Directory Services

The Internet Connection wizard may prompt you for information about e-mail or
Internet Directory Services. These wizard screens appear when you create a new
Internet connection or open Microsoft Outlook Express for the first time.

You can use Outlook Express to send and receive e-mail over the Internet. You
can use Outlook Express to view Usenet newsgroups. And you can use the
Internet Directory Service to record your Address information in many phone
book-like resources on the Internet.
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Before using the wizard to set up these features, you need the following
information from your ISP:

» Your e-mail address, for example:
yourname@mycompany . com

» Identification requirements, such as a Secure Password Authentication or a
user ID and password.

» The type and name of the server that processes your incoming mail.
For example, your incoming mail might be processed by a POP3 type server
named “SERVER99.”

= The name of the server that processes your outgoing mail. For example,
it may also be “SERVER99.”

» The name of your Internet news (NNTP) server and its log-on requirements,
if any. For example, it may also be “SERVER99.”

= The name of your Internet directory (LDAP) server and its log-on
requirements, if any.

Configuring Your Internet Connection

When you set up Internet connections, an icon for each connection is created in
the Dial-Up Networking folder, which you can find in My Computer. If you
connect to multiple ISPs, you'll create multiple icons in this folder. Each
connection may have different dialing properties, including different phone
numbers, a different user name and password, or other settings. This section
describes how to manually change three of those settings: protocols, IP addresses,
and DNS addresses.

Changing Your Internet Protocol

Essentially, a protocol is the language that two computers use to communicate.
Most ISPs use the PPP protocol when connecting your computer to the Internet.
Some ISPs use other protocols, such as SLIP or CSLIP. Your ISP should tell you
what protocol to use or provide you with a setup program that selects a protocol
automatically.

» To change your Internet protocol

1. In the Dial-Up Networking folder, right-click the icon for the connection you
want to change.

2. In the shortcut menu that appears, click Properties.



Chapter5 Advanced Issues 97

3. Click the Server Types tab.

4. In Type of Dial-Up Server, select an Internet protocol from the list, and then
click OK.

Note If you’re using a modem to connect to the Internet, you can speed up the
initial connection process by clearing the checkboxes for Log on to a network,
NetBEUI, and IPX/SPX Compatible.

Entering Your IP Address Manually

Every computer connected to the Internet has an IP address, a unique number that
identifies one computer to the others. When you connect, your ISP usually grants
your computer an IP address automatically. In some cases, though, you need to
enter the IP address manually. Your ISP should tell you if this is the case and
provide you with an IP address.

To enter an IP address manually

1. In the Dial-Up Networking folder, right-click the icon for the connection you
want to change.

2. In the shortcut menu that appears, click Properties.

3. Click the Server Types tab.

4. Click TCP/IP Settings, and then select Specify an IP address.

5. In IP address, type the IP address provided by your ISP, and then click OK.

Entering Your DNS Address Manually

To find addresses on the Internet, your computer needs to connect to a Domain
Name Server (DNS), which assigns IP addresses. In most cases, a DNS address is
automatically assigned by your ISP. If your ISP requires that you set the DNS
address on your computer, you need to enter the address manually.

To enter a DNS address manually

1. In the Dial-Up Networking folder, right-click the icon for the connection you
want to change.

. In the shortcut menu that appears, click Properties.
. Click the Server Types tab.
. Click TCP/IP Settings, and then select Specify name server addresses.

. In Primary DNS, type the DNS address provided by your ISP. You can also
enter a secondary DNS address, if needed. Click OK when finished.

“v A WN
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Logging On Manually to an ISP

After you’ve made a connection to an ISP, you log on to its network automatically
in most cases. An ISP using an older server may require that you use a terminal
window to log on manually. Your ISP will tell you if you need to do this.

» To set a connection for opening a terminal window

1. In the Dial-Up Networking folder, right-click the icon for the connection you
want to change.

2. In the shortcut menu that appears, click Properties.
3. On the General tab, click Configure.

4. Click the Options tab, select an option in Connection control, and then click
OK.

Every time you use this connection, the Terminal Screen appears. In this screen,
the ISP prompts you for information (such as a pre-assigned user name and
password). You’ll type the appropriate information after each prompt. The ISP
then connects you to the Internet. If you frequently use this connection, you can
automate the logon process by using a script.

é} For information about using a script, look up “script files, Dial-Up Networking”
T on the Index tab in Windows Help.

In Windows 98, you can use the Add Printer wizard to quickly set up printers,
select default printers, and change printer settings. The wizard guides you step-by-
step through printer setup.

) For additional information about printing, look up “Printing” on the Contents tab
E; in Windows Help. For step-by-step assistance with identifying and correcting a
printing problem, see “Print” under Troubleshooting on the Contents tab in
Windows Help.
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Setting Up a Printer

4

Before you begin, make sure your printer is correctly connected to your computer,
that the power is on, and that you know the make and model of the printer. If
you’re planning to use a printer shared over a network, you may also need to
know the path (for example, \accounting\printer!). You can also browse for the
printer in Network Neighborhood and then double-click the printer icon to set it

up.

Note If any printers are already set up, their icons appear in the Printers folder.
To view the Printers folder, click the Start button, point to Settings, and then
click Printers.

To set up a printer
1. Click Start, point to Settings, click Printers, and then double-click Add
Printer.

2. Follow the instructions on your screen. The remaining steps vary depending on
whether you choose to set up a local printer or a network printer.

= In most cases, if you’re setting up a printer that’s attached to your
computer, you should choose LPT1 as the port.
= If you’re setting up a network printer, you’re prompted to type the network

path or queue name. If you don’t know this information, click Browse to
locate the printer, or ask your network administrator.

3. When you finish, the icon for your printer appears in the Printers folder. Your
printer is ready for use.

Determining the Default Printer

Your print jobs are always sent to the default printer unless you specify otherwise.
In the Printers dialog box, the default printer has a check mark beside its icon.
You can change your default printer at any time.

To set a default printer

1. Click Start, point to Settings, and then click Printers.

2. Right-click the icon of the printer you want to set as the default.
A shortcut menu appears.

3. Select Set as Default.
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Printing a Document

After you set up a printer, you can easily print your documents. In many
programs, the Print command is available on the File menu.

» To print an open document

»  On the File menu, click Print.

Frequently Asked Questions

Printing

The following list of frequently asked questions (FAQ) provides a quick way for
you to find answers to common questions about Windows 98. For the latest
information about these and other Windows 98 issues, visit the Support Online
Web site at the following address:

http://support.microsoft.com/support

Do | have to add a printer during Setup?

If during Setup you’re asked to add a printer, you can skip this step by clicking
Cancel. You can add a printer later by using the Add Printer wizard.

For information about adding a printer after Windows is installed, see “Setting Up
a Printer,” earlier in this section.

Why won't my document print?

For step-by-step assistance with identifying and correcting a printing problem, see
“Print” under Troubleshooting on the Contents tab in Windows Help.

How can | troubleshcot my network printing setup?

If you’re having trouble printing to a network printer, you should perform the
following checks:

= Make sure you have the appropriate permissions to access the network printer.
You may need to ask your network administrator to give you the proper rights.

* Make sure you use the correct syntax when typing the printer name. You must
use two backslashes to begin a printer share name. For example, a printer share
name could lcok like this: \accounting\printer1
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Desktop Options

The Internet

How can | change to the single-click option?

By default, you open files and folders by double-clicking their icons. If you prefer
more Web-like navigation, you can easily change to single-click browsing. To
change your browsing options, you change your desktop style. For more
information about desktop styles, see “Choosing a Desktop Style” in Chapter 4,
“Customizing Your Desktop.”

What is the Active Desktop?

Using the Active Desktop, you can display Web content as your wallpaper. The
content can include Web pages, documents, or channels. Whether you use a Web
or Classic style desktop, you can use the Active Desktop feature. For more
information, see “Using the Active Desktop” in Chapter 4, “Customizing Your
Desktop.”

Can | make my desktop look and act like Windows 957

You can turn off any or all of the following features: single-clicking, the Active
Desktop, Channel Bar, and Web-like folder view. For information about turning
these features off, see Chapter 4, “Customizing Your Desktop.”

Next, you need to hide the Active Desktop, if it’s showing. To hide the Active
Desktop, you right-click a blank area of the desktop, point to Active Desktop, and
then click to clear the View As Web Page check mark.

Finally, you reed to hide any toolbars displayed on the taskbar and in windows.
To remove a toolbar from the taskbar, right-click a blank area on the taskbar,
point to Toolbars, and then click the name of the toolbar.

Why does the Internet Connection wizard open?

The Internet Connection wizard collects information required for you to use the
Internet. The wizard may open the first time you open a Web page or HTML file.
To read more about the wizard, see “Setting Up an Internet Connection,” earlier in
this chapter.

Why am | getting a “Navigation Canceled” message?

If you aren’t connected to the Internet, you might receive this message when you
try to jump to a Web page or use the Search Explorer Bar. See “Why do I receive
an error message when I’m connecting to a Web page?” for more solutions.
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Why do | receive an error message when I'm connecting to a Web page?
Occasionally, the Web page you want to view won’t open. When this happens,
you receive an error message in a dialog box or on a Web page. For example, you
may receive the error “HTTP/1.0 404 Object Not Found,” which means that the
Web page you’re trying to view may not exist.

Often, the only alternative is to try connecting to the site at a later time, but there
are other solutions you can try:

= Update the page by clicking Refresh.

= Click Back to return to the page you were just viewing, and then click the link
to the page you want to view.

= If you typed an address for a Web site, check for errors.

= Display a different site. If you can connect to another site, the Web page you
originally tried to visit either doesn’t exist or is malfunctioning.

= [f you can’t connect to any Web site, then the problem is probably with your
Internet connection. Make sure you’re still connected to your ISP and that your
modem is working.

What's a channel?

A channel is a Web site designed to deliver content from the Internet to your
computer. A content provider determines when and what information is available
for each channel. To view the content in a channel, you click one of the channel
buttons on the Channel Bar.

The Channel Bar displays all of the channels installed on your computer. You
don’t have to subscribe to a channel to view it, but the channel is added to the
Channel Bar if you do subscribe. When you first install Windows 98, the Channel
Bar appears on your desktop. If you close the Channel Bar at any time, you need
to add it back to your desktop.

For information about channels, see Chapter 4, “Customizing Your Desktop.”

What’s a subscription?

A subscription is a way to have Windows 98 automatically check your favorite
Web pages for new content. You select how and when you are notified—
Windows 98 automatically delivers the new content to your computer on a regular
basis.
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What's the difference between a subscription and a channel?

A subscription is a tool for automatically downloading any Web page, including
channels, to your computer according to a schedule that you set up. A channel is a
kind of Web site specially designed to deliver content to your computer. You can
follow a content delivery schedule suggested by the content provider, or you can
set up your own schedule by subscribing to the channel.

For more information about using subscriptions and channels, see Chapter 4,
“Customizing Your Desktop.”

General Issues

Why can’tl find a certain feature?

Many Windows 98 features—such as games, accessibility options, WebTV for
Windows, Backup, and multimedia tools—are optional components. If you can’t
locate a feature, it may not have been installed during Windows installation. To
install an option after Windows 98 is already installed, double-click the
Add/Remove Programs icon in Control Panel, click the Windows Setup tab,
select the item(s) to install, and click OK.

What's the Favorites folder?

Favorites is a folder in which you can store shortcuts to Web pages, subscriptions,
folders, and files that you frequently use. You can easily open Favorites from the
Start menu.

For information about managing Favorites, look up “Favorites” on the Index tab
in Internet Explorer Help.

How do | use My Documents?

My Documents, which is new to your desktop for Windows 98, is the default
storage location for documents you create. For example, if you create a Microsoft
Excel spreadsheet, Excel saves the spreadsheet in My Documents unless you
specify another location.

To change the default storage location for a program’s files, see the program’s
documentation.

What's the Users icon in Control Panel?

The new Users icon in Control Panel allows you to view, modify, and delete the
user profiles on your computer. User profiles are settings—desktop appearance,
Start menu, passwords, and so on—unique to each person using your computer.
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How do | start Windows in troublesheoting mode?

You can start your computer in safe mode, a minimal version of Windows useful
for troubleshooting hardware and driver problems. If you press CTRL at startup
(after power-on tests but before Windows 98 starts), a list of startup choices
appears. Safe mode is one of the choices on this list.

In safe mode, Windows 98 uses default settings (VGA monitor, no network
connection, a Microsoft Mouse driver, and the minimum device drivers required
to start Windows). You won’t have access to CD-ROM drives, printers, or other
devices. Safe mode enables you to troubleshoot major problems by allowing you
to start Windows, change settings, and then restart Windows to see if the problem
has been corrected.

What's IEEE 13947

IEEE 1394 is a connection standard to allow the control of various hardware—
including VCRs, stereos, and so on—through your computer. It’s not the same as
the Universal Serial Bus (USB) standard.

For more information, look up “IEEE 1394 devices, ports” on the Index tab in
Windows Help.
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Using a Mouse

A mouse is a hand-held device that controls the movement of a pointer on your
screen. You use your mouse to perform tasks on your computer.

Note “Using Your Mouse,” an interactive tutorial, may be included in your copy
of Windows 98. If it’s available, you can find it in the “Computer Essentials”
section of the Discover Windows 98 online tutorial. For information about how to
open Discover Windows 98, finish reading this appendix, and then see Chapter 1,
“Welcome.”

[% As you move the mouse, a mouse pointer moves on your screen. When you
position the pointer over an object, you can press (click or double-click) the
mouse button to perform different actions on the object. For example, you can
double-click to open and work in files, click-and-drag to move files, and click to
select files. In fact, you’ll probably use your mouse for most tasks. The pointer
usually appears as an arrow, but it can change shape.

The following sections explain the other actions you can perform with your
mouse.
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Pointing and Clicking

You perform most of the tasks on your computer by pointing at an object on your
screen, and then clicking a mouse button. To point to an object, move the mouse
until the tip of the mouse pointer is over the item or area you want.

The following table describes common click actions.

Action Description
. E Click: Press and release the left mouse button once.
% Double-click: Quickly press and release the left mouse button twice.
Right-click: Press and release the right mouse button once. A shortcut
menu appears.

é You can switch left and right mouse buttons. For more information, look up
*“mouse” on the Index tab in Windows Help.
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Dragging

Moving objects on your screen is a lot like moving objects around your desk. For
example, clicking and dragging an icon is a lot like physically picking up a pencil
with your hand and dropping the pencil in a new location. Similarly, to move a
screen object, you first position the mouse pointer on the object. Next, you “pick
up” the object by pressing and holding down the left mouse button. While you’re
still holding down the mouse button, move the mouse pointer to where you want
to “drop” the object, and then release the mouse button. The following illustration
demonstrates dragging a document to a folder.
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You also drag to select text, such as words in a document or the name of a file. To
select text, you first insert your cursor (a blinking vertical line) where you want to
start the selection. Then you hold down the left mouse button, move the mouse
pointer to where you want to end the selection, and release the mouse button.

For more information, look up “dragging files, folders™ on the Index tab in
Windows Help.
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Internet Basics

This appendix introduces the Internet and explains how you can explore its
contents.

For information about connecting to the Internet using the Internet Configuration
wizard, see “Internet Setup” in Chapter 5, “Advanced Issues.”

Learning About the Internet and the Web

The Internet is essentially a large number of connected computers. A computer on
the Internet can be located anywhere in the world, so you can communicate with
someone over the Internet no matter where that person lives.
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For information about
advanced Intemet
features such as
Microsoft Chat and
Microsoft NetMeeting,
see Intemet Explorer
Help.

The Internet contains several different types of information, including e-mail,
newsgroups, and the World Wide Web.

Software needed
Feature (example) What can I do with this program?
E-mail E-mail software Send messages and documents.
(Outlook Express,
Microsoft Exchange)
Newsgroups News reader Read messages on various topics.
(Cutlook Express,
Internet News)
Web Web browsing Read documents, listen to music, watch videos,
software make purchases, participate in surveys,

advertise products, do research, share interests,
and download files.

The Worid Wide Web is the graphical, multimedia portion of the Internet. To view
files on the Web, you need Web browsing software. You use this software to view
different locations on the Web, which are known as Web pages. A group of Web
pages is a Web site. The first page of a Web site is often called the home page.

HOME

]
Il

I,
jmguﬂ Il
I

Il
I
I
Il

Just as each household in the world has a unique address, each Web page in the
world has a unique Internet address, sometimes called a URL. For example, the
Internet address of the Windows home page is

http://www.microsoft.com/windows
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Exploring the Internet

When you use
Internet Explorer, you
don’t have to type
http:// before the
beginning of a Web
address.

To see all of the
buttons on the toolbar,
you may need to
increase the size of
the Internet Explorer
window.

You can browse Web pages—or “surf the Net”—in several ways. You can open
any Web page by typing its address in the Address box of your Web browsing
software. And when you're viewing a Web page, you can navigate the Internet by
clicking links—underlined text or special pictures that, when clicked, cause you to
Jump to another Web page. When you move the mouse pointer over a link, the
mouse pointer changes to a hand. When you click a link, another Web page
appears.

You can also use toolbar buttons to move between Web pages, search the
Internet, or to refresh a Web page’s content.
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The following table describes the Internet Explorer toolbar buttons and how you
can use them to navigate the Internet.

Button Description

Back Moves to a previously viewed Web page.

Forward Moves to the next Web page.

Stop Stops the downloading of a Web page.

Refresh Updates the currently displayed Web page (reloads the currently
displayed page).

Home Jumps to your home page.

Search Opens a Web page that lists the available search engines.

Favorites Displays a list of Web pages you've designated as your favorites.

History Displays a list of recently visited sites.

Channels Displays a list of the channels you can select.

Fullscreen Uses a smaller Standard toolbar and hides the Address bar so more of
the screen is visible.

Mail Opens Outlook Express or Internet News.

Print Prints a Web page.

Edit Opens FrontPage Express so you can edit a Web page.

To learn more about the Internet and how to move around Web pages, take the
Internet Explorer tutorial. To start the tutorial, use the following procedure or type
www.microsoft.com/magazine/guides/internet/ in the Address Bar.
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» To open the Internet Explorer Web Tutorial
1. On the desktop, double-click Internet Explorer.

wmor

to the

Internet
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Accessibility for People with
Disabilities

Microsoft is committed to making its products and services easier for everyone to
use. This appendix provides information about the following features, products,
and services, which make Windows 98 more accessible for people with
disabilities. It includes:

= Microsoft technical support for people who are deaf or hard-of-hearing

= Features in Windows 98 that make using Windows easier for people with
motion or hearing disabilities

= [nformation about other products and services for people with disabilities

Windows 98 includes more features and customization for people with disabilities
than ever before, including:

= Accessibility wizard Helps you set Windows options to meet your vision,
hearing, and mobility needs.

= Magnifier application Allows you to enlarge a portion of your screen
display for easier viewing.

= New high-contrast desktop color schemes Provide you with more ways to
change the appearance of colors, font sizes, and styles on your screen.

= New higher-visibility mouse pointer schemes Give you more options to
visually help you keep track of the pointer.
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Technical Support for Individuals Who Are
Deaf or Hard - of - Hearing

Through a text telephone (TT or TDD) service, Microsoft offers complete access
to product and customer support for users who are deaf or hard-of-hearing.

You can call the following numbers Monday through Friday, excluding holidays.
You can contact Microsoft Sales Information Center on a text telephone by
dialing (800) 892-5234 between 6:30 A.M. and 5:30 P.M. Pacific time. For
technical assistance in the United States, you can contact Microsoft Technical
Support on a text telephone at (425) 635-4948 between 6:00 A.M. and 6:00 p.M.
Pacific time. In Canada, dial (905) 568-9641 between 8:00 A.M. and 8:00 p.M.
Eastern time. Microsoft Technical Support is subject to Microsoft prices, terms,
and conditions in place at the time the service is used.

Windows Accessibility Features

Windows 98 includes several Accessibility features for your display, sound,
mouse, and keyboard settings that provide users who have motion or hearing
disabilities with better access to computers that run Windows. For example, if it's
difficult for you to use a mouse, you can change the MouseKeys settings so that
you can use the numeric keypad to move the mouse pointer. The following
illustration shows which keys to use.
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Before you can start using Accessibility features in Windows 98, you must first
install Accessibility options. Use the following procedures to install Accessibility
options, and then run the Accessibility wizard and Microsoft Magnifier.

To install Accessibility options

1.
2.

Click the Start button, point to Settings, and then click Control Panel.

Double-click Add/Remove Programs, and then click the Windows Setup
tab.

Select the Accessibility Options check box, click OK, and then follow the
instructions that appear on your screen.

If you upgraded from a previous version of Windows and you had Accessibility
options installed, you must update these options before you can use the
Accessibility features unique to Windows 98.

To update Accessibility options

1.
2.

Click the Start button, point to Settings, and then click Control Panel.

Double-click Add/Remove Programs, and then click the Windows Setup
tab.

. Clear the Accessibility check box, click OK, and then follow the instructions

that appear on your screen.

4. Click the Start button, point to Settings, and then click Control Panel.

. Double-click Add/Remove Programs, and then click the Windows Setup

tab.

. Select the Accessibility check box, click OK, and then follow the instructions

that appear on your screen.

To use the Accessibility wizard

L.

Click the Start button, point to Programs, point to Accessories, point to
Accessibility. and then click Accessibility Wizard.

The Accessibility wizard starts.

. Follow the instructions in the wizard.
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» To use Microsoft Magnifier

1. Click the Start button, point to Programs, point to Accessories, point to
Accessibility, and then click Magnifier.
The Microsoft Magnifier dialog box appears. A separate area at the top of the
screen shows an enlarged view of the portion of your screen near your pointer.

2. Select a magnification level and options, and then click OK.
The magnified area remains on your screen until you close the Microsoft
Magnifier dialog box. You can place your pointer over the horizontal line and
drag up or down to resize the magnification area.
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é For more information, look up “accessibility” on the Index tab in Windows Help.
For a listing of Accessibility shortcut keys, see “Keyboard Shortcuts™ later in this

appendix.
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Customizing Windows

You can adjust the performance of Windows 98, your mouse, and your keyboard
to suit varying vision and motor abilities without adding any additional software
or hardware. Application note WN1062 describes the specific methods. If you

have a modem, you can download application notes from the following services:

@ http://www.microsoft.com/enable

= Microsoft Download Service (MSDL), which you can call at (425) 936-6735
anytime except between 1:00 A.M. and 2:30 A.M. Pacific time. Use the
following communications settings.

For this setting Specify

Baud rate 1200, 2400, 9600, or 14400
Parity None

Data bits 8

Stop bits 1

Documentation in Alternative Formats

Most Microsoft publications are available from Recording for the Blind and
Dyslexic, Inc. Recording for the Blind and Dyslexic distributes these documents
to registered, eligible members of its distribution service, either on audiocassettes
or on floppy disks. More than 80,000 titles are available, including Microsoft
product documentation and books from Microsoft Press. You can contact
Recording for the Blind and Dyslexic at:

Recording for the Blind and Dyslexic, Inc.
20 Roszel Road
Princeton, NJ 08540

Voice telephone: (609) 452-0606
Fax: (609) 987-8116
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More Information for People with Disabilities

For more information about Microsoft products and services for people with
disabilities, you can contact:

Microsoft Sales Information Center
One Microsoft Way
Redmond, WA 98052-6399

Voice telephone: (800) 426-9400
Text telephone: (800) 892-5234
To receive a fax: (800) 727-3351 or (425) 635-6100

You can visit the Microsoft Accessibility and Disabilities site on the World Wide
Web at:

http://www.microsoft.com/enable

The Trace R&D Center at the University of Wisconsin-Madison produces a book
and a compact disc that describe products that help people with disabilities use
computers. The Trace Resource Book provides descriptions and photographs of
about 2000 products. The CO-NET CD provides a database that lists more than
18,000 products and provides other information for people with disabilities. The
CO-NET CD is issued twice a year. To obtain these materials, contact:

Trace Research & Development Center
University of Wisconsin-Madison
S-151 Waisman Center

1500 Highland Avenue

Madison, WI 53705-2280

TTY: (608) 263-5408
Fax: (608) 262-8848
E-mail: info@trace.wisc.edu

You can visit the Trace Research & Development Center site on the World Wide
Web at:

http://trace.wisc.edu/
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For general information and recommendations about how computers can help in
specific cases, consult a trained evaluator who can best match your individual
needs with available solutions. An assistive technology program in your area can
provide referrals to available programs and services. To locate the assistive
technology program nearest you, you can contact:

National Information System (NIS)
Center for Developmental Disabilities
Benson Bldg.

University of South Carolina
Columbia, SC 29208

Voice/text telephone: (803) 777-1782
Fax: (803) 777-9557

Keyboard Shortcuts

You can use keyboard shortcuts with Windows 98. For more information, look up
“shortcut keys” on the Index tab in Windows Help.

Accessibility Shortcut Keys

Before you can use any Accessibility shortcut key. you need to enable it within
the Accessibility Options in Control Panel.

To Press

Switch FilterKeys on and off RIGHT SHIFT for eight seconds
Switch High Contrast on and off LEFT ALT+LEFT SHIFT+PRINT SCREEN
Switch MouseKeys on and off LEFT ALT+LEFT SHIFT+NUM LOCK
Switch StickyKeys on and off SHIFT five times

Switch ToggleKeys on and off NUM LOCK for five seconds
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General Windows Keys

To quickly open shortcut menus, you can use the APPLICATION key on a Microsoft
Natural Keyboard or any other compatible keyboard that includes the

APPLICATION key.
To Press
Activate the menu bar in programs F10

Carry out the corresponding command
on the menu

Close the current window in Multiple
Document Interface (MDI) programs

Close the current window or quit a
program

Copy

Cut

Delete

Display Help on the selected dialog box
item

Display the current window’s system
menu

Display the shortcut menu for the
selected item

Display the Start menu

Display the system menu for MDI
programs

Paste
Switch to the window you last used
—Or-

Switch to another window by holding
down ALT while repeatedly pressing TAB

Undo

ALT+underlined letter in menu

CTRL+F4

ALT+F4

CTRL+C
CTRL+X
DELETE
F1

ALT+SPACEBAR

SHIFT+F10

CTRL+ESC
ALT+HYPHEN (-)

CTRL+V
ALT+TAB

CTRL+Z
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For the Desktop, My Computer, and Windows Explorer

When an item is selected, you can use the shortcut keys shown in the following

table.
To

Press

Bypass AutoPlay when inserting a CD

Copy a file
Create a shortcut

Delete an item immediately without
placing it in the Recycle Bin

Display Find: All Files

Display the item’s shortcut menu
Refresh the contents of a window
Rename an item

Select all items

View an item’s properties

To

SHIFT while inserting the CD

CTRL while dragging the file
CTRL+SHIFT while dragging the file
SHIFT+DELETE

F3

APPLICATION KEY

F5

F2

CTRL+A

ALT+ENTER or ALT+DOUBLE-CLICK

For My Computer and Windows Explorer Only

Press

Close the selected folder and all of its

parent folders
Move backward to a previous view

Move forward to a previous view

For Windows Explorer Only

SHIFT while clicking the Close button

ALT+LEFT ARROW
ALT+RIGHT ARROW

View the folder one level up BACKSPACE
To Press
Collapse the current selection if it’s LEFT ARROW

expanded

—Or-

Select the parent folder
Collapse the selected folder

Expand the current selection if it’s
collapsed,

-Or-
Select the first subfolder
Expand the selected folder

NUM LOCK+MINUS SIGN (-)
RIGHT ARROW

NUM LOCK+PLUS SIGN (+)
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For Dialog Boxes

To

Press

Cancel the current task

Click the corresponding command
Click the selected button

Move forward through options
Move backward through options
Move forward through tabs

Move backward through tabs

Click a button if the current control is
a button

-Or-

Select or clear the check box if the
current control is a check box

~Or-

Click the option if the current control
is an option button

Open a folder one level up if a folder
is selected in the Save As or Open
dialog box

Open Save In or Look In in the Save
As or Open dialog box

Refresh the Save As or Open dialog
box

ESC
ALT+underlined letter
ENTER

TAB

SHIFT+TAB

CTRL+TAB
CTRL+SHIFT+TAB
SPACEBAR

BACKSPACE

F4

F5
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For Internet Explorer Only

To Press
Activate a selected link ENTER
Display a shortcut menu for a link SHIFT+Fi0
Go to a new location CTRL+O

Go to 1-ext page

Go to previcus page

Move back between frames

Move back between links

Move forward between frames

Move forward between links

Move to the beginning of a document
Move to the end of a document

Open a new window

Print the current page or active frame
Refresh the current page

Scroll toward the beginning of a
document

Scroll toward the beginning of a
document in larger increments

Scroll toward the end of a document

Scroll toward the end of a document
in larger increments

Stop downloading a page

ALT+RIGHT ARROW
ALT+LEFT ARROW
SHIFT+CTRL+TAB
SHIFT+TAB
CTRL+TAB

TAB

HOME

END

CTRL+N

CTRL+P

F5

UP ARROW

PAGE UP

DOWN ARROW
PAGE DOWN

ESC
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Glossary

This glossary defines technical terms and
concepts. In each chapter, glossary terms are
italicized at first mention.

A

Active Desktop A feature that allows you to use
Web pages or channels as your desktop wallpaper.
See also channel, wallpaper.

ActiveX A Microsoft technology that provides
interactive content on Web pages.

address The location of a file. You can use
addresses to find files on the Internet and your
computer. Internet addresses are also known as
URLSs. See also Address Bar.

Address Bar A method of opening files that are
on the Internet or your computer. When you type
an address in the Address Bar, you open the file at
that address. See also AutoComplete.

application See program.
arrow See pointer.

AutoComplete A feature in the Address Bar.
When you begin typing a previously used address,
this feature finishes it as you type.

B
bitmap A type of file used for pictures.

browse To navigate the Internet or the contents
of your computer.

browser See Web browsing software.

C

cache A folder that temporarily stores files on
your computer.

CD-ROM (compact disc read-only memory)

A high-capacity form of storage, also called a
compact disc or CD. You must have a CD-ROM
drive to use these discs. CD-ROMs don't allow
users to store information.

channel A Web site that delivers content from
the Internet to your computer. Channels
automatically copy content from the Internet to
your computer when you subscribe to a Web site.
See also Channel Bar.

Channel Bar A desktop option that lists the
channels available on your computer.

Classic style A desktop display option that
resembles the Windows 95 desktop.

client A computer that connects to another,
central computer called a server. A client
computer uses files, printers, and other resources
shared by the server. See also server.

content provider A business that uses the Internet
to supply you with information such as news,
weather, business reports, and entertainment.

Control Panel A group of tools you use to change
hardware and software settings.

D

default A predefined setting. For example, the
double-click option is the default setting in
Microsoft Windows 98.
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defragmentation The process of rewriting a file to
adjacent sections of a hard disk. Over time, parts
of the same file can become fragmented—that is,
spread over different areas on a hard disk.
Fragmentation causes slower disk speed.
Windows 98 includes the Disk Defragmenter,
which may help improve disk performance. See
also file allocation 1able.

desktop Your workspace on the computer screen.
See also Active Desktop.

dialog box A window in which you provide
information to a program.

Dial-Up Networking A feature that allows you to
use a phone line and modem to connect to another
computer.

disk drive Hardware on which you can store files.
Drives are assigned a letter. For example. most
users store their files on their hard disk. which is
typically labeled “C".

document A file you create when you save your
work in a program. Examples of documents
include word-processing files, spreadsheets, and
bitmaps.

domain A group of networked computers that
share information and resources.

download To copy files from one computer to
your own by using a modem or a network
connection. For example, you download files
from the Web to your hard disk.

drive See disk drive.

driver Software that the operating system uses to
control a specific piece of hardware.

DVD A high-capacity compact disc. This disc can
store enough data for a full-length movie. You
must have a DVD disc drive or player to use DVD
discs.

electronic mail See e-mail.

e-mail Electronic messages sent from one person
to another over the Internet or a network. E-mail
can contain both text and files.

Explorer Bar A pane that opens on the left side of
windows, such as when you click the Search
button or Favorites button.

F

Favorite A link to a favorite Web page.
file A program or document stored on a disk.

file allocation table (FAT) A method used by
operating systems to keep track of where files are
stored on a hard disk. See aiso defragmentation;
file system.

file system The overall structure in which files
are named, stored, and organized by the operating
system. For example, MS-DOS and earlier
versions of Windows use the FAT16 file system.
Windows 98 can use the FAT16 or FAT32 file
system.

folder A location in which you can store files and
other folders.

H

HTML (Hypertext Markup Language)

The language used to create Web pages. You
must use Web browsing software to view HTML
documents. See also Web page.

home page The introductory page of a Web site.
The home page typically contains links to other
pages in the site.

Hypertext Markup Language See HTML.
hyperlink See link.
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icon A picture representing a program, disk
drive, file, folder, or other item.

Internet A worldwide network of computers. If
you have access to the Internet, you can retrieve
information from millions of sources, including
schools, governments, businesses, and
individuals. See also World Wide Web.

Internet address See address.

Internet service provider (iSP) A company or
organization that provides Internet access, usually
for a fee. Generally, you use your modem to
connect to your ISP.

intranet A private network within an
organization. An intranet can be connected to the
Internet.

J

jump To move from one Web page to another.

L

LAN See local area network.

link Text or a picture that you click to jump from
one location to another. The mouse pointer
usually changes to a hand when positioned over a
link.

local area network (LAN) A group of connected
computers in the same location.

legon To identify yourself and gain access to a
computer. To log on, you typically type a user
name and a password.

menu A list of commands that appears at the top
of most windows.

modem Hardware that transmits data from one
computer to another, often across phone lines. See
also Dial-Up Networking.

mouse pointer An icon, typically an arrow, that
appears on your screen and is controlled by the
movement of the mouse. You use the mouse
pointer to work with menus, icons, links, and
other screen objects.

multimedia Any combination of text, pictures,
sound. and video.

My Computer A feature you can use to manage
files stored on your computer or network drives.
You can also gain access to system tools from My
Computer. The My Computer icon appears on
your desktop.

N

network Two or more connected computers.
Networks are used for sharing resources such as
documents, programs, and printers. See also
workgroup.

network card Hardware that you insert in a
computer to connect the computer to a network.

0

offline Not connected to a network or the
Internet.

offline reading To view a Web page without
being connected to the Internet. You can
download the page to your hard disk, disconnect
from a network or the Internet, and read the
material later.

online service An Internet service that provides a
wide range of content to its subscribers, including
Internet access.

operating system Software, such as Windows 98,
that runs your computer. An operating system
controls programs and hardware.
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P

path The means of navigating to a specific
location on a computer or network. A path can
include a computer name, disk drive label, folder
names, and a file name.

pointer See mouse pointer.

profile A collection of Windows 98 settings for a
specific user. Profile information includes user
settings such as color schemes, screen savers, and
desktop backgrounds, so that multiple users can
retain their own preferences.

program A group of instructions your computer
uses to perform specific tasks. For example,
Microsoft Word is a word-processing program.
Programs are also called applications.

protocol A set of rules computers use to
communicate with each other over a network.

R

refresh

To redisplay the contents of a Web page or
window.

remote user
A person who connects to a network by using a
modem and Dial-Up Networking.

right-click To click an item by using the
secondary mouse button, which is typically the
right button. You can display a shortcut menu by
right-clicking an item.

S

search engine A tool that searches the Web for
information you want to find. You can click the
Search button in any window to display a list of
Web-based search engines.

server A computer that controls users’ access to a
network. A server stores and controls shared
resources that can be used by other computers,
called clients. See also client.

shortcut An icon that links to a file or folder.
When you double-click a shortcut, the original
item opens.

shortcut menu The menu that appears when you
right-click an object.

shut down To use the Shut Down command,
which prepares the computer to be turned off or
restarted.

subscribe To set up Internet Explorer to check a

Web page for new content. The program can then
notify you about the new content or automatically
download it to your computer.

T

taskbar A tool you use to open programs and
navigate your computer. Usually found at the
bottom of your screen, the taskbar contains the
Start button, toolbars, a clock, and other features.

toolbar A set of buttons you click to perform
common tasks.

ToolTip A brief description of a screen object.
ToolTips appear when you position the mouse
pointer over objects.

U

Universal Serial Bus (USB) A hardware standard
for external device connections (such as a mouse,
modems, game controllers, and keyboards). USB
supports Plug and Play installation so that you can
easily add new devices to your computer without
having to add an adapter card or shut down.

URL (Uniform Rescurce Locator)
See address.
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L

wallpaper The background on your desktop. You
can select a background from bitmaps and HTML
documents included in Windows 98, or you can
choose from your own files.

Web See World Wide Web.

Web browsing software Software you use to
explore the World Wide Web, HTML documents,
and other information sources. Internet Explorer
is the Web browsing software included with
Windows 98.

Web page A location on the World Wide Web,
usually a part of a Web site. The term “Web
page” is sometimes used to describe any HTML
document.

Web site A group of related Web pages.

Web style A desktop display option. In Web
style, you can navigate your computer by using
such Web conventions as single-clicking.

window The rectangular portion of your screen
that displays an open program or the contents of a
folder or disk. You can have multiple windows
open at the same time.

Windows Explorer A feature you can use to view
the contents of your computer and network drives
in a hierarchical structure.

wizard A tool that walks you through the steps of
a complex task.

workgroup A set of networked computers that
typically share the same resources, such as
printers. A network can be comprised of many
workgroups. See also network.

World Wide Web (the Web) The graphical,
multimedia portion of the Internet. The Web is
comprised of millions of Web pages. To explore
the Web, you use Web browsing software. See
also Internet, Web page.
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A Addresses (continued)
Trace R&D Center 118
Access control 90-91 URLs See URLs
Accessibility information Adjacent items, selecting 48
for the deaf or hard-of-hearing 114 Anti-virus software, converting to FAT32 file system 86. 87
installing options 115 Application notes, downloading from network services 117
keyboard shortcuts 119-123 Applications See Programs
Microsoft Magnifier 19 As Web Page command 66
Recording for the Blind documentation 117 AutoComplete feature 125
Trace Resource Book 118 Automatically displaying Web content 67-70
updating options 115
Web site 118 B
Windows features 114
Accessibility wizard 19, 115 Back button 61, 111
Active Desktop Background
adding items 65,72 customizing display properties 72
cham?e:ls 12 displaying Web content 13, 55, 66
deﬁnmqn 125 scheduling tasks to runin 18
dgscﬁpf:on 101 Backing up data
displaying Web pages 11 Backup tool updated for Windows 98 18
hidmg 101 before installing Windows 98 80-81
overview 63-65 in Windows 3.1 80-81
refreshing content 65 in Windows 95 81
showing or hiding 65 in Windows 98 82
ActiveX 125 Startup Disk 26, 83, 86
Add/Remove Programs 103 Bitmaps 125
creating Startup Disk 83 Blind, accessibility 117
installing programs 43-44 Books, tutorials and resource kits from Microsoft Press 8
uninstalling Windows 98 84 Browsing
Adding adding optional tools 59-62
browsing tools 59-62 computer contents 12
Channel Bar to desktop 69 customizing options 58
items to Active Desktop 65, 72 definition 125
printers 99 Explorer Bars 61-62
shortcuts to Start menu 38 Internet 111-112
toolbars to windows 59-60 network resources 42
window background 66 Web browsing software 110, 129
Address Bar Buttons
definition 125 Back 61
introduced 11 controlling windows 23
toolbar overview 59, 61 customizing toolbars 59~60
Addresses displaying or hiding names 59
definition 125 Forward 61
DNS address 97 Internet Explorer 111
1P address used for Internet 97 right and left, mouse 106
Microsoft Sales Information Center 118 Show Desktop 14
Recording for the Blind and Dyslexic 117 taskbar overview 38

setting up e-mail 96
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c

Cabling computers together 89
Cache 125
CD-ROM
definition 125
driver on Startup Disk 83
viewing drives in My Computer 40
Channels
Channel Bar 69-70, 125
definition 125
description 102-103
Explorer Bar 61
Internet Explorer button 111
introduced 12
overview 68-70
Characters
computer names 32
conventions used in this book viii
file names 46
Classic style desktop view 54, 57, 101, 125
Clicking
common actions 106
conventions used in this book viii
frequently asked questions 101
jumping to Web pages 111
single-click option 12
taskbar buttons 38
Web style desktop view 55-56
Client software 88
Clients 88, 125
Close button 23
Closing
programs 45
Windows 98 50-51
Clusters 85
Communications
Dial-Up Networking 93-94, 126
Internet Explorer 20
settings for downloading application notes 117
Compact Setup 31
Computer Essentials online tutorial 3
Computer name 32
Computers
dual-booting, converting to FAT32 file system 86
Maintenance wizard 18, 79
network servers and clients described 88
Portable Setup 31
shutting down 50-51
starting with Startup Disk 83
system requirements for Windows 98 26
Connecting to
anetwork 88-89
remote servers See Dial-Up Networking

Connecting to (continued)
Internet
configuring connections 96-97
easier access with Windows 98 10-12
overview 94
setting up Internet service providers 95
Comtent providers 2, 125
Control Panel
Add/Remove Programs 43-44, 103
changing monitor settings 76
connecting to networks 89
creating Startup Disk 83
customizing desktop display properties 72
definition 125
installing accessibility options 115
opening 22
setting up Dial-Up Networking 93-94
uninstalling Windows 98 84
Users control panel 103
Conventions used in this book viii
Converting to FAT32 file system 86-87
Copying files and folders 48
Create Shortcut(s) Here command 49
Custom Settings dialog box 58
Custom Setup 31
Custom style desktop view 54, 57
Customize this Folder command 66
Customizing
accessibility options See Accessibility information
browsing options 58
desktop
display properties 72
for multiple users 73
Start menu 74
taskbar 74, 75
toolbars 59-60
windows 117

D

Deaf or hard-of-hearing, accessibility 114
Default
definition 125
printer 99
Defragmenting hard disk 88, 126
Deleting
files and folders 50
Windows 98 84
Desktop
Active Desktop
adding items 65, 72
channels 12
definition 125
description 101
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Desktop (continued)
displaying Web pages 11
hiding 101
overview 63-65
refreshing content 65
showing or hiding 65
adding Channel Bar 69
changes from Windows 95 14-15
Classic style desktop view 57
creating shortcuts 49
customizing
browsing options 58
display properties 72
for multiple users 73
definition 126
described 9, 36
frequently asked questions 101
keyboard shortcuts 121
styles 54-58, 101
Web style desktop view 55-56
Diagnosing problems using Dr. Watson 18
Dialog boxes
definition 126
keyboard shortcuts 122
Dial-Up Networking
configuring connections 96-97
connection properties 94
definition 126
DNS address 97
IP address 97

logging on to Internet service providers manually 98

overview 93-94

server types 94, 96

using terminal window 98

viewing folder 40
Direct Cable Connection 89
Directory services, setting up 95-96
Disabilities See Accessibility information
Discover Windows 98 online tutorial 3,9
Disk Defragmenter utility 88
Disks

See also Drives

definition 126

high-density DVD drives 17

Startup Disk 26, 83, 86

viewing in My Computer 40
Display properties, customizing 72
Displaying

Active Desktop 65

button names 59

drives in My Computer 40

Explorer Bars 62

files and folders 38

folders as Web pages 66

network drives 42

Displaying (continued)

Printers folder 22

Start menu 39

ToolTips 59

Web content
as window background 13
automatically 67-70
in windows 66

on Active Desktop See Active Desktop

troubleshooting 102

DNS address 97
Documents

definition 126

dragging 107

printing 100

selecting text 107
Domain Name System (DNS) address 97
Domains :

definition 126

logging on to Windows 98 33
DOS prompt See MS-DOS, prompt
Double-clicking

See also Clicking

common actions 106

conventions used in this book viii

vs. single-click browsing 101
Downloading

application notes from network services 117

definition 126
Dr. Watson 18
Dragging with mouse 107
Drive Converter wizard 87
Drivers
CD-ROM, on Startup Disk 83
definition 126
Drives
CD-ROM, driver on Startup Disk 83
definition 126
FAT32 file system 84-88
high-density DVD 17
network, displaying 42
partitions 84-85
viewing in My Computer 40

Dual-booting, converting to FAT32 file system 86

DVD technology
described 17
DVD discs 126

Edit button 111
Electronic mail See E-mail
E-mail

address 96
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E-mail (continued)
definition 126
Internet 110
Outlook Express 21,95
server types 96
setting up 95-96
subscriptions 67
Enlarging screen display 116
Explorer See Windows Explorer
Explorer Bars 61-62, 126
Exploring the Internet 111-112

F

FATI6 file system 85-86
FAT32 file system 84-88, 126
Favorites Explorer Bar 61
Favorites folder
added to Start menu 15
definition 126
description 103
File Allocation Table See FAT32 file system
File Manager 22
File system
See also FAT32 file system
definition 126
Files
adding shortcuts to Start menu 38
backing up
Backup tool updated for Windows 98 18
before installing Windows 98 80-81
in Windows 98 82
browsing
customizing options 58
opticnal tools 59-62
Windows 98 changes 12
copying 48
creating shortcuts 49
customizing Start menu and taskbar 74-75
definition 126
deleting 50
desktop icons 36
displaying as Web pages 66
dragging 107
file names 46
finding 47
frequently used 48-49
moving
overview 48
to My Documents 49
opening 47
renaming 48
search changes in Windows 98 15-16

Files (continued)
selecting 48
sharing 90-92
viewing 38

FilterKeys 119

Finding
files and folders 47

information, enhj in Windows 98 15-16

network printers 100
Product Key 30
Floppy disks
Startup Disk 26, 83, 83, 86
viewing drives in My Computer 40
Folders
adding shortcuts to Start menu 38
backing up
Backup tool updated for Windows 98 18
before installing Windows 98 80-81
in Windows 98 82
browsing
customizing options 58
optional tools 59-62
Windows 98 changes 12
copying 48
creating 46
creating shortcuts 49
Customize this Folder command 66
customizing Start menu and taskbar 74-75
definition 126
deleting 50
desktop icons 36
displaying as Web pages 66
dragging 107
Favorites 15, 103, 126
finding 47
moving 48
My Documents 48-49, 103
opening 47
Printers 22
renaming 48
search changes in Windows 98 15-16
selecting 48
sharing 90-92
viewing 38
Forward button 61, 111
Frequently asked questions about
desktop options 101
Internet 101-103
printing 100
Frequently used files 48—49
FrontPage Express 13
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G

Getting Started book
conventions used viii
online version 6
overview vii

H

Hand mouse pointer 111
Hard disks
defragmenting 88
FAT32 file system 84-88
partitioning 84-85
system requirements for Windows 98 26
viewing in My Computer 40-41
Hard-of-hearing, accessibility 114
Hardware
connecting to networks 88
IEEE 1394 standard 104
innovations in Windows 98 19
multiple monitors 75-76
Startup Disk 83
Troubleshooters included with Windows 98 78-79
TV tuner card 71
Universal Serial Bus (USB) standard 2
Hardware Compatibility List (HCL) 7, 26
Help
application notes from network services 117
for the deaf or hard-of-hearing 114
Microsoft Technical Support Web site 78
on dialog boxes 72
opening 5
registering Windows 98 33
Troubleshooters included with
Windows 98 17, 78-79
Windows accessibility features 114
Hiding
Active Desktop 65, 101
button names 59
toolbars 101
High Contrast accessibility feature 119
High-density DVD drives 17
History button 111
History Explorer Bar 61
Home button 111
Home pages 110, 126
HTML
definition 126
documents
creating with FrontPage Express 13
using as window background 13, 55
e-mail 21

Hyperlinks 111, 127
HyperText Markup Language See HTML

Icons
clicking 106
definition 127
desktop 36
dragging 107
My Computer 40
IEEE 1394 standard 104
Installing
accessibility options 115
FAT3?2 file system 86-87
PCI graphics adapters 75
printers 99
programs 43-44
WebTV 71
Windows 98
Add/Remove Programs 103
backing up files 80-81
from the MS-DOS prompt 29-30
multiple graphics adapters 76
Product Key 30
registering 33
Setup options 30-32
Startup Disk 26, 83, 86
system requirements 26
upgrading from Windows 95 27-29
Internet
browsing 10
Channels Explorer Bar 61
connecting to
easier access with Windows 98 10-12
introduction 7
definition 127
exploring 111-112
Favorites Explorer Bar 61
finding information 15-16
frequently asked questions 101-103
History Explorer Bar 61
Microsoft Internet Referral system 95
Navigation Canceled message 101
overview 109-110
reading Web content offline 70, 127
Search Explorer Bar 61
setting up
Dial-Up Networking 93-94
Internet service providers 95
typing addresses in Address Bar 11, 59, 61
vs. intranet 127
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Internet (continued)
Web sites
See also URLs
Internet Explorer tutorial 111
Microsoft Accessibility and Disabilities 118
Microsoft Technical Support 78
Windows 98 7
Windows Support Caline 7, 100
Internet Connection wizard 10, 94, 101
Internet Directory services 95-96
Internet Explorer
browsing 10
Channel Bar 69-70
communicating 20
exploring the Internet 111-112
keyboard shortcuts 123
search changes in Windows 98 15-16
tutorial 111
Web browsing software 110
Internet Service Providers (ISPs)
configuring connections 96-97
definition 127
description 94
DNS address 97
IP address used for Internet 97
logging on manually 98
Microsoft Internet Referral system 95
new, setting up 95
setting up Dial-Up Networking 93-94
Intranets 127
IP address used for Internet 97
ISPs See Internet Service Providers

J

Jumping to Web pages 111,127

K

Keyboard
shortcuts 119-123
Windows keys 120
Knowledge Base 7

L

LANs 95, 127

Links 111,127

Local area networks (LANs) 95, 127

Logging events using Dr. Watson 18

Logging on
definition 127
manually to an Internet service provider 98
to Windows 98 32-33

Long file names 46
LPT1 printer port 99

Maintenance wizard 18,79
Map Network Drive command 42
Maximize button 23
Memory

cache 125

system requirements for Windows 98 26
Menus

customizing 59

keyboard shortcuts 122

Start menu overview 38
Messages, e-mail See E-mail
Microsoft Accessibility and Disabilities Web site 118
Microsoft Download Service (MSDL) 117
Microsoft Internet Referral system 95
Microsoft Knowledge Base 7
Microsoft Magnifier 19, 116
Microsoft NetMeeting 20
Microsoft NetShow 17
Microsoft Outlook Express 21, 95-96
Microsoft Press tutorials, books, and resource kits 8§
Microsoft Program Guide 17, 71-72
Microsoft Sales Information Center 118
Microsoft technical support

for the deaf or hard-of-hearing 114

registering Windows 98 33

Web site 78
Minimize button 23
Missing features 103
Modems

definition 127

setting up Dial-Up Networking 93-94

speeding up Internet connection process 97
Monitors

changing display settings 76

changing screen resolution 72

multiple

hooking up 19
using 75-76

system requirements for Windows 98 26
Mouse

clicking See Clicking

conventions used in this book viii

description 105

dragging 107

hand pointer 111

interactive tutorial 105

right and left buttons 106

selecting text 107

system requirements for Windows 98 26
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MouseKeys 114, 119
Moving
files and folders 48
files to My Documents 49
MS-DOS
prompt
access by Startup Disk 83
installing Windows 98 29-30
starting MS-DQOS-based programs 23
starting MS-DOS-based programs 23
Multimedia entertainment 17
Muttiple moriters 75-76
Multiple users, customizing desktop for 73
My Computer
description (27
keyboard shortcuts 121
overview 40-41
viewing files and folders 38
My Documents folder 48-49, 103

Names
Identification screen in Setup 32
network printers 100
Naming files 46, 48
Navigation Canceled message 101
NetMeeting 20
NetShow 17
Network
cards
connecting to the Internet 94
definition 127
client software 88
connecting to 88-89
definition 127
described 42, 88
Dial-Up Networking
overview 93-94
viewing folder 40
displaying drives 42
intranets 127
local area networks (LANs) 95, 127
logging on to Windows 98 33
Map Network Drive command 42
printers
printer names 100
setting up 99
sharing 90-92
troubleshooting 100
protocols 88
services 88
sharing folders and printers 90-92
viewing drives in My Computer 40

Network Neighborhood
displaying network drives 42
overview 42-43 °
sharing network resources 90-92
viewing files and folders 38
New features since Windows 95 10-21
New tools in Windows 98 19
New users
resources included with Windows 98 3-7
Windows desktop described 9
Newsgroups
description 110
setting up 95-96
Nonadjacent items, selecting 48
Notational conventions used in this book viii

o)

Offline Web content 70, 127
Online Help See Help
Online services
connecting to the Internet
easier access with Windows 98 10-12
introduction 7
definition 127
downloading application notes 117
Microsoft Internet Referral system 95
setting up Internet service providers 95
Onlire tutorials 3-4, 8,9
OnNow power management 19
Opening
Control Panel 22
files and folders 47
Internet Explorer tutorial 111112
MS-DOS-based programs 23
online Help 5
Printers folder 22
Program Manager 21
programs 14, 44-45
recently used documents 49
Run command 22
Troubleshooters 79
WebTV 72
Windows Explorer 4]
Windows Support Online Web site 100
Operating systems 127
Qutlook Express 21, 95-96

P

Partitioning hard disks 84-85

Password, logging on to Windows 98 32
Path 128

PCI graphics adapters 75
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Personalizing See Customizing
Pointer, mouse 105, 111, 127
Portable Setup 31
Power management, OnNow 19
Print Manager, Windows 98 equivalent 22
Printers
See also Printing
default 99
folder, viewing 22
frequently asked questions 100
network printer names 100
setting up 99
sharing 90-92
viewing in My Computer 40
Printing
See also Printers
documents 100
frequently asked questions 100
Internet Explorer 111
Problems See Troubleshooting
Product Key 30
Product support
for the deaf or hard-of-hearing 114
Microsoft Technical Support Web site 78
registering Windows 98 33
Profiles
description 128
managing 103
Program Manager
running 21
Windows 98 equivalent 21
Programs
adding shoricuts to Start menu 38
closing 45
definition 128
desktop icons 36
installing 43-44
opening from taskbar 14
opening recently used documents 49
Run command 22
starting 44-45
viewing 38
Protocols
configuring Internet connections 96
definition 128
described 88
Dial-Up Networking server types 94, 96
speeding up Internet connection process 97

Q

Quick Launch toolbar 14, 59
Quitting

programs 45

Windows 98 50-51

R

Reading Web content offline 70, 127
Readme documents 6
Recently used documents 49
Recording for the Blind documentation 117
Recycle Bin, deleting files and folders 50
Refresh button 111
Refreshing
content on Active Desktop 65
definition 128
Registering Windows 98 33
Remote users 128
Removing
files and folders 50
programs 43-44
toolbars from taskbar 101°
Windows 98 84
Renaming files and folders 48
Resources included with Windows 98 3-7
Restore button 23
Right-clicking
See also Clicking
common actions 106
conventions used in this book viii
creating shoricuts 49
definition 128
Run command
running Setp 27-28
starting programs 45
using 22

S

Scheduling tasks to run in background 18
Screen saver, setting 72
SCSI tape devices, Backup tool 18
Search engine

definition 128

illustrated 15
Search Explorer Bar 61
Searching

for files and folders 47

in Windows 98 15-16
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Sectors 85
Selecting
adjacent items 48
keyboard shortcuts 122
nonadjacent items 48
text 107
Servers
definition 128
Dial-Up Networking 94, 96
e-mail 96
networks described 88
Services
network 88
online services 127
text telephone 114
Setup See Installing, Windows 98
Shared resources
browsing network 42
FAT32 file system 86

share-level and user-level control 90

sharing files
on dial-in computers 93
on networks 90, 92

Shortcut menus 128
Shortcuts

adding to Start menu 38

creating 49

definition 128

description 48

keyboard 119-123
Show Desktop button 14
Shut Down command 50-51, 128
Single-clicking

See also Clicking

described 12

frequently asked questions 101

Web style desktop view 55-56
Smart Favorites subscriptions 67
Start button

overview 38

viewing files and folders 38
Start menu

adding shortcuts 38

customizing 74

Favorites folder 15, 103

overview 38

starting programs 44-45

turning off your computer 50-51

viewing 39
Starting

computers using Startup Disk 83

Starting (continued)
Control Panel 22

Discover Windows 98 online tutorial 4

FAT32 Drive Converter 87

Internet Explorer tutorial 111-112

Microsoft Backup 82
MS-DOS-based programs 23
online Help 5
Program Manager 21
programs 14, 44-45
Run command 22
Start button 21
Troubleshooters 79
WebTV 72
Windows 98 32-33
Windows Explorer 41
Startup Disk 26, 83, 86
StickyKeys 119
Stop button 111
Storing data 84
Subscriptions 11, 66-68, 102, 128
Symbols
used in this book viii
window control buttons 23

System requirements for running Windows 98 26

T

Tape drives, backing up data 18
Taskbar
customizing 74, 75
customizing toolbars 59-60
definition 128
opening programs quickly 14
overview 38
removing toolbars 101
TDD service 114
Technical support

for the deaf or hard-of-hearing 114
Microsoft Technical Support Web site 78

registering Windows 98 33
Television, watching 17, 71-72

Terminal window, logging on to Internet service providers 98

Text telephone service 114

ToggleKeys 119

Toolbars
Address Bar 61, 125
Channel Bar 69-70, 102, 125
custontizing 59-60
definition 128
Explorer Bars 61-62
Internet Explorer 111
Quick Launch 14,59
removing from taskbar 101
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Tools
for changing computer settings 40
new in Windows 98 19
ToolTips 59, 128
Trace R&D Center 118
Trace Resource Book 118
Training resources 8, 111
Troubleshooting
Internet issues 101-103
Microsoft Technical Support Web site 78
missing features 103
Navigation Canceled message 101
printing 100
speeding up Internet connection process 97
Troubleshooters included with Windows 98 7, 17, 78-79
using Dr. Watson 18
TT service 114
Turning off your computer 50-51
Tutorials
Discover Windows 98 3-4,9
Internet Explorer 111
Microsoft Press publications 8
mouse 105
Typical Setup 31
Typographic conventions used in this book viii

U

Uniform Resource Locators See URLs
Uninstalling Windows 98 83, 84, 86
Universal Serial Bus (USB) standard 2, 19, 128
Updating
accessibility options 115
content on Active Desktop 65
subscriptions 68
URLs
description 110
Hardware Compatibility List (HCL) 7, 26
Internet Explorer tutoriat 111
Microsoft Accessibility and Disabilities 118
Microsoft Press Web site 8
Microsoft Technical Support Web site 78
Windows 98 Web site 7
Windows home page 110
Windows Support Online Web site 2, 7, 100
USB See Universal Serial Bus
User Guides and references for Windows 98 8
User name, logging on to Windows 98 33
User profiles
description 128
managing 103
User-level vs share-level contro! 90

Users
control panel for managing user profiles 103
multiple, customizing desktop 73
remote (28

v

Viewing
channel content 69-70
drives in My Computer 40
files and folders 38
Microsoft Magnifier 116
network drives 42
Printers folder 22
Start menu 39
subscriptions 68
Web content as it becomes available 67-70

w

Wallpaper
definition 129
setting 72
Watching TV 17,71-72
Web browsing software 110, 129
Web pages
See also Web sites
channels 68-70
creating with FrontPage Express 13
Customize this Folder command 66
definition 110, 129
displaying
automatically 67-70
folders as 66
in windows 66
on desktop 11
reading offline 70, 127
troubleshooting display 102
using as window background 13, 55
Web sites
See aiso Internet; URLs
browsing using Explorer Bars 61-62
channels
description 102-103
introduced 12
deftnition 110, 129
Hardware Compatibility List (HCL) 7, 26
Internet Explorer tutorial 111
Microsoft Accessibility and Disabilities 118
Microsoft Press 8
refreshing content on Active Desktop 65
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Web sites (continued)
subscriptions
adding 67
channels 69-70, 102-103
definition 128
description 102
introduced 11
overview 67
updating all 68
viewing 68
typing Internet addresses in Address Bar 11, 59, 61
Windows 98 7
Windows Support Online Web site 2
Web style desktop view 54-56; 66, 129
Webcasting
See also Subscriptions
described 17
WebTV 17,71-72
What's New online tutorial 3
Windows
control buttons 23
customizing 117
definition 129
displaying
Web content 66
Web pages as background 13, 55
enlarging screen display 116
removing toolbars 101
running MS-DOS-based programs 23
Windows 3.1
backing up data before installing Windows 98 80-81
changes in Windows 98 21-23
installing Windows 98 28-29
Windows 95
backing up data before installing
Windows 98 81
changes in Windows 98 10-21
classic style desktop view 54, 57, 101, 125
upgrading 1o Windows 98 27-29
Windows 98
accessibility features 114
additional resources 7-8
backing up data 82
changes
desktop 14-15
from Windows 3.1 21-23
from Windows 95 10-21
desktop See Desktop
features 2-3
hardware innovations 19
keyboard shortcuts 119-123
logging on 32-33
missing features 103

Windows 98 (continued)
multimedia entertainment 17
new tools 19
online Help 5
online tutorials 3—-4
Readme documents 6
registering 33
resources included 3-7
setting up Internet service providers See Installing,

Windows 98
system requirements 26
Troubleshooters 7, 17, 78-79
tutorials 8,9, 111
uninstalling 83, 84, 86
upgrading
from Windows 3.1 28-29
from Windows 95 27-28
Web site 7
Windows Explorer
equivalent of File Manager 22
description 129
Explorer Bars 61-62
keyboard shortcuts 121
overview 41
viewing files and folders 38
Windows home page 110
Windows Support Online Web site
additional resources 7
visiting 100
Windows 98 main features 2
Wizards
Accessibility 19, 115
definition 129
Disk Defragmenter utility 88
Drive Converter 87
Internet Connection 10, 94, 101
Maintenance 18,79
Windows 98 Setup 27-30
Workgroups 32, 129
World Wide Web
See also Intemnet; URLs
connecting to
easier access with Windows 98 10-12
introduction 7

definition 129

exploring 111-112

overview 109-110

setting up Internet service providers 95
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